PRODUCTS/SERVICES, SUCH LIABILITY SHALL BE LIMITED TO THE AMOUNT PAID BY THE USER TO QUARK FOR THE SOFTWARE/SERVICES AT ISSUE (EXCLUDING THIRD PARTY PRODUCTS/SERVICES), IF ANY, OR THE LOWEST AMOUNT UNDER APPLICABLE LAW, WHICHERVER IS LESS. THESE LIMITATIONS WILL APPLY EVEN IF QUARK, THE QUARK AFFILIATED COMPANIES, THEIR LICENSORS AND/OR THEIR AGENTS HAVE BEEN ADVISED OF SUCH POSSIBLE DAMAGES. SOME JURISDICTIONS, STATES OR PROVINCES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION OR EXCLUSION MAY NOT APPLY. ALL OTHER LIMITATIONS PROVIDED UNDER APPLICABLE LAW, INCLUDING STATUTES OF LIMITATION, SHALL CONTINUE TO APPLY.

IN THE EVENT ANY OF THESE PROVISIONS ARE OR BECOME UNENFORCEABLE UNDER APPLICABLE LAW, SUCH PROVISION SHALL BE MODIFIED OR LIMITED IN ITS EFFECT TO THE EXTENT NECESSARY TO CAUSE IT TO BE ENFORCEABLE USE OF THE QUARK PRODUCTS IS SUBJECT TO THE TERMS OF THE END USER LICENSE AGREEMENT OR OTHER APPLICABLE AGREEMENTS FOR SUCH PRODUCT/SERVICE. IN THE EVENT OF A CONFLICT BETWEEN SUCH AGREEMENTS AND THESE PROVISIONS, THE RELEVANT AGREEMENTS SHALL CONTROL.

Quark, QuarkXPress, Quark Digital Media System, Quark Publishing System, QuarkCopyDesk, QPS, QuarkDDS, XTensions, and QuarkDMS are trademarks of Quark Inc. and all applicable affiliated companies, Reg. U.S. Pat. & Tm. Off. and in many other countries. The Quark logo is a trademark of Quark Inc. and all applicable affiliated companies.

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and/or other countries.

As to the Apache software, copyright ©1999–2000 The Apache Software Foundation. All rights reserved. Any Apache software which is distributed with this software is software developed by the Apache Software Foundation (http://www.apache.org/). APACHE SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes code licensed from RSA Data Security.

Sun, Sun Microsystems, the Sun Logo, Solaris, all Sun based, Java and all Java based trademarks are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries, and are used under license.

As to the Java-Com bridge technology, Copyright ©1999–2001 Dan Adler, 315 E72 St. NY, NY, 10021, USA. mail to: danadler@rcn.com. All rights reserved.
Redistribution and use in source and binary forms, with or without modification are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. Redistributions in any form must be accompanied by information on how to obtain complete source code for the JACOB software. Redistribution of the JACOB software is not permitted as part of any commercial product that is targeted primarily at Java developers. Such products include, but are not limited to: Java Virtual Machines, integrated development environments, code libraries, and application server products. Licensing terms for such distribution may be obtained from the copyright holder.

THIS SOFTWARE IS PROVIDED, “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Mac OS is a registered trademark of Apple Computer, Inc. in the U.S.A. and other countries. As to the omniORB library, Copyright ©1996–1999 AT&T Laboratories Cambridge. The omniORB library is free software; you can redistribute it and/or modify it under the terms of the GNU Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the License, or (at your option) any later version. This library is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public license for more details. You should have received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free Software Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307.

As to Microsoft technology, ©1988–2005 Microsoft Corporation. All rights reserved. As to the OpenORB library, Copyright ©1999–2001 Intalio, Inc. All Rights Reserved. Redistribution and use of the OpenORB software and associated documentation (“Software”), with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a copy of this document. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The name “ExoLab” must not be used to endorse or promote products derived from this Software without prior written permission of ExoLab Group. For written permission, please contact info@exolab.org. 4. Products derived from this Software may not be called “ExoLab” nor may “ExoLab” appear in their names without prior written permission of ExoLab Group. Exolab is a registered trademark of ExoLab Group. 5. Due credit should be given to the ExoLab Group (http://www.exolab.org).
THIS SOFTWARE IS PROVIDED BY INTALIO, INC. AND CONTRIBUTORS “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTALIO, INC. OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

All other marks are the properties of their respective owners.
**Introduction**

- About this Guide  
- What we assume about you  
- What you will see

**1 Getting started with Quark License Administrator**

- Understanding Quark License Administrator  
- QLA Server  
- Quark License Administrator Clients  
- QLA Control Panel  
- Understanding license types  
- Runcount Pool  
- Node-lock List  
- Node-lock Pool  
- Auxiliary Pool  
- Extended Licenses  
- Remote License Files  
- Communicating license usage data to Quark  
- XTensions module Licensing  
- After Installing Quark License Administrator

**Launching the Quark License Administrator Server component**

- Starting QLA Server when it runs as a service  
- Starting the backup server  
- License Information

**Accessing Quark License Administrator**

- Logging on to QLA Control Panel  
- Changing your password  
- Logging off of the QLA Control Panel
Shutting down the Quark License Administrator Server component 9
Shutting down when the server runs as a service 9
Understanding the Emergency Key Launch feature for Quark Applications 10
Using the QLA Server Interface 10
Server Status (area) 12
Server Details (area) 12
Stop Server (button) 12
Refresh (button) 12
Using the QLA Control Panel user interface 12
Menus 13
Tabs 15

2 Specifying Quark License Administrator Settings

Viewing license file information and assignments 19
Viewing admin hierarchy 19
Viewing license file information 20
Viewing XTensions licenses associated with QuarkXPress 21
Using the user parameters tab 22
License Configuration (area) 23
License Keys (dialog box) 23
Site Information (area) 24
Configuring Quark License Administrator 25
Server Configuration (area) 26
Extended check-out configuration (area) 26
Configuring e-mail notifications 27
License Usage Notification (area) 28
Server status Notification (area) 28
License File Expiration Notification (area) 29
Enable application Expiration Notification (area) 29
## 3 Administering Licenses

### Monitoring multiple administrators 30
- Creating Local Administrators 30
- Editing Local Administrators 32
- Deleting Local Administrators 33
- Resetting Forgotten Passwords 33

### Allocating licenses 34
- Using the runcount pool 34
- Creating a node-lock list or a node-lock pool 34
- Editing a node-lock list or a node-lock pool 36
- Deleting a node-lock list or a node-lock pool 37

### Working with remote license files 38
- Generating a remote license file 38
- Generating Remote License files for use in the future 42
- Modifying a remote license file 42

### Working with extended licenses 44
- Checking out an extended license for QuarkXPress 44
- Checking in an extended license for QuarkXPress 45
- Viewing Information about extended pool licenses 45

### Increasing runcount using the Auxiliary Pool 47
- Configuring an auxiliary license 47

### Viewing license check-out status 48

### Monitoring license activities through the system log 50
- Monitoring Quark License Administrator activity 50
- Accessing the system Log 51
4 Notifications and Alerts

Primary Server not available 54
Primary Server available 54
Backup Server not available 54
Backup Server available 54
License usage reaching a pre-defined percentage of the total runcount 55
Remote Check-out License reaching pre-defined number of days of allocated duration 55
Time-bombed license about to expire 55
License File reaching pre-defined number of days of allocated duration 55

Appendix A: Troubleshooting

Issues and workarounds 56
Server hard drive Failure 56
A Quark licensed product has been reinstalled 56
Changed port numbers 56
Using the system log for troubleshooting 57
Errors 57
Events 63
Alerts 70

Appendix B: Post-installation Activities

Using Emergency License files 73
Changing contact information 74
Recovering forgotten passwords 75
Downloading new license files 76
Changing the server name or port number 78

Glossary
Introduction

Before you begin, take time to review this chapter so that you understand how the guide is structured and how you can get the most out of it.

ABOUT THIS GUIDE

You do not need to read the Quark License Administrator User Guide from cover to cover. Instead, use this guide to quickly look up information, find out what you need to know, and proceed with your work. Use the detailed table of contents at the beginning of the guide to quickly find information.

WHAT WE ASSUME ABOUT YOU

In writing this book, we assume that you are familiar with your computer and know how to:

• Launch an application
• Open, save, and close files
• Use menus, dialog boxes, and windows
• Work within a networked computing environment
• Use the mouse, keyboard commands, and modifier keys

Consult the documentation provided with your computer or other resources if you need more information in any of these areas.

WHAT YOU WILL SEE

Various conventions (styles) in this guide highlight information to help you quickly find what you need.

BOLD TYPE STYLE

The names of all dialog boxes, fields, and other controls are set in bold type. For example, “Check Register and Download a License File in the Registration Information screen to register QLA Server and download your license file from Quark.”

REFERENCES AND ARROWS

In descriptions of features, parenthetical references guide you in accessing those features. You will often see arrows (→), which map out the menu path to a feature. For example, “To find the DNS name or IP address, choose Start → Control Panel → Network.”
ICONS
Rather than using the text name of each graphical element in the user interface, steps in this user guide feature only the icon of the button or tool you need to select to perform tasks. For example, “click ☐ to change the runcount that you assign to the local administrator.”

NOTES
Notes cover additional information about particular features or concepts. They may also contain suggestions to improve your workflow or to perform a step more efficiently.

CROSS-PLATFORM CONVENTIONS
This guide accommodates all platforms for which Quark® License Administrator (QLA) is available; some terms are more familiar to users of different operating systems. For example, you will see the term “Quit,” which is typically a Mac OS® term, instead of “Exit,” which is a Windows® term.

When the different operating systems require different keyboard commands, this guide uses the following conventions: “Press Option (Mac OS) or Alt (Windows).”
Chapter 1: Getting started with Quark License Administrator

A license is permission to use software that you purchased for your company. When you purchase five or more copies of a Quark application, the Quark License Administrator (QLA) software, which is included with the application, simplifies the installation and maintenance of the application on multiple computers. It also gives you flexibility in handling the complexities of license management by letting you (or your super administrator) create multiple local administrators and assign a license to an individual computer, a person, or an entire group. You can even allow a user to check out a license and remain disconnected from the network for a specified period. In addition, you can accommodate freelancers, contractors, and employees who work on the road with remote license files that allow them to run Quark applications from remote sites.

After installing the QLA software and downloading the license file, you are ready to log on to the QLA Control Panel to configure license access for users. After launching QLA Server, you can use the QLA Control Panel software to log on to it from your server or any client computer.

System administration of QLA is set up as a hierarchy, with the super administrator at the top, local administrators under the super administrator, and sub-administrators under the local administrators. See Chapter 3, “Administering Licenses,” for more information about this hierarchy.

UNDERSTANDING QUARK LICENSE ADMINISTRATOR

The QLA system consists of three main components: the QLA Server, the clients, and the QLA Control Panel. Together, these components provide everything you need to manage licenses for your Quark products.
QLA is designed for system administrators. To use this software, you must have administrator privileges to modify system parameters and the ability to load software onto a network.

**QLA SERVER**
QLA Server is the software component that issues licenses to the Quark application clients. After you install QLA Server, you must download your license file from the Quark Web site. The server can be any computer on your network that meets the minimum system requirements. For information about the minimum system requirements and detailed instructions about installing QLA, see the “Installation Instructions.pdf” file on the QLA CD-ROM. The server monitors license usage over the network and grants licenses to the client computers.

**QUARK LICENSE ADMINISTRATOR CLIENTS**
QLA clients are the computers on which Quark applications are installed. For example, you install QuarkXPress®, Quark Digital Media System®, Quark Publishing System® Classic Edition, Quark® Data Integration Toolkit, or Quark Dynamic Document Server® (QuarkDDS®) software on your client computers. When a user attempts to launch a Quark application on a client computer, the client sends a request to the QLA server. The server determines whether any licenses are available. If a license is available, the server grants a license, and the client computer launches the Quark application. If no licenses are available, the server does not grant a license, and the client does not launch the Quark application.

**QLA CONTROL PANEL**
You can install the QLA Control Panel on the QLA server, or on any of the client computers. Use the QLA Control Panel to create and update license files for freelancers, contractors, and other remote users; create local administrators; view the log file; and generate reports about license usage.

**UNDERSTANDING LICENSE TYPES**
You can assign three different types of QLA licenses: runcount pool, node-lock list, or node-lock pool. Additionally, you might be able to request auxiliary licenses or check out extended licenses on an as-needed basis.

**RUNCOUNT POOL**
By default, the *runcount pool* is the total number of licenses you purchased for your Quark application. As you assign licenses to other lists or pools, they are removed from the runcount pool. Licenses from the runcount pool are granted on a first-come, first-served basis to users or computers that are not assigned to node-lock lists or node-lock pools.
NODE-LOCK LIST

A node-lock list assigns licenses to specific users or computers. A node-lock list defines a one-to-one relationship between the users or computers on the list and the number of licenses allocated to the list. For example, your five users require five licenses, and the node-lock list ensures that a license is always available when any member of the group needs one. When you allocate licenses to a node-lock list, those licenses are reserved for the members of the list and are unavailable for the general runcount pool or a node-lock pool.

NODE-LOCK POOL

A node-lock pool is a group of users and computers that share a specified number of licenses. Typically, the number of members in the pool exceeds the number of licenses allocated to the pool. A node-lock pool is useful when you have a number of users or computers that do not need the application all the time. In such a configuration, the chance of such users accessing a license is good, and some licenses are available for the general runcount pool or a node-lock list. When you allocate licenses to a node-lock pool, those licenses are always reserved for the members of the pool and are unavailable for the rest of the users on your network.

AUXILIARY POOL

Some Quark customers are able to purchase auxiliary licenses on an as-needed basis. If you need more licenses than you purchased and you do not have time to wait before ordering more, you may be able to use auxiliary licenses to increase your runcount pool. Auxiliary licenses are temporary; they last for only a temporary period, which is determined by Quark.

The availability of auxiliary licenses is based on a percentage of your total number of licenses; not all customers qualify for an auxiliary pool. For more information about qualifying for an auxiliary pool and guidelines for using auxiliary pools, contact your Quark representative.

EXTENDED LICENSES

Use the Extended Licenses feature to use a license for a specified period without a connection to the QLA server. When a user checks out a license, QLA temporarily removes it from the available pool of licenses. An extended license user or computer can be a member of any list or pool except the auxiliary pool. When a user or computer requests an extended license, QLA removes the license from the corresponding pool, and adds it to the extended pool for the duration it is checked out.

The extended pool is useful when users need to use a Quark application on a computer that must be removed from the network for a while. For example, a user can use a laptop to check out a license and then remove the laptop from the network for use in a remote location.
Users can also use the extended pool when they do not want to connect to the QLA server each time they launch their Quark applications. For example, you can specify a one month check-out interval, and users can launch the application for a month without connecting to the QLA server.

Extended licenses are not available for QuarkDMS, QuarkDDS, and QPS® Classic Edition.

REMOTE LICENSE FILES
Use the remote license file to enable users to launch Quark applications from remote locations without ever connecting to the QLA server. Remote license files are useful for freelancers, contractors, and other remote users who cannot visit the office daily.

The remote license file is customized with all the necessary information, including the IP address, the physical address of the user’s computer, and the expiration date of the license file. When this file is used at a remote location, Quark applications do not search for the QLA server because the file contains all the relevant information for the application to start.

When you generate a remote license file, you temporarily remove the runcount license from the available pool of licenses. Just as with the extended license check out, a remote license file is issued for a specific duration. When the remote license file expires, the application no longer launches on the user’s computer, and the QLA Server checks in the runcount license automatically.

You can generate remote license files for future use by specifying a future start and end date. When you generate a remote license file for use in the future, you temporarily remove the runcount license from the available pool of licenses for the duration you specify.

COMMUNICATING LICENSE USAGE DATA TO QUARK
The QLA server automatically monitors license usage throughout the network and stores information about this usage in an encrypted file.

Usage can be monitored by a Quark representative during an on-site visit. Quark representatives will not view your personal files, but they will copy an encrypted file that contains usage data. This file resides on your system and contains the date, serial number of the Quark application, and usage information.
XTENSIONS MODULE LICENSING
In addition to monitoring QuarkXPress and QuarkCopyDesk® licenses, QLA Server monitors XTensions® module licenses associated with QuarkXPress. This capability makes possible efficient and one-point management of all your licenses.

QLA Server manages only XTensions module licenses associated with QuarkXPress. This functionality does not extend to licenses for QuarkCopyDesk.

AFTER INSTALLING QUARK LICENSE ADMINISTRATOR
After the successful installation of QLA, you might encounter situations in which you need to use the emergency license file, change the contact information, recover a forgotten password, or download the license file again.

For information about the post-installation activities, see “Appendix B” later in this user guide.

LAUNCHING THE QUARK LICENSE ADMINISTRATOR SERVER COMPONENT
To start QLA Server on Mac OS or Windows, double-click the “QLAServer” file (Mac OS) or the “QLAServer.exe” file (Windows) in the “Server” folder inside your QLA application folder. On Solaris, open the console window (cd Quark_License_Administrator/Server), enter ./QLAServer in the command prompt, and press Enter.

On Mac OS or Windows, you can also double-click the shortcut icon on the desktop, which is created automatically when you install the software.

YOU must launch the primary server before you launch the backup server for the first time. Otherwise, the servers will not synchronize, and you will be unable to log on to the backup server.

Mac OS only: Before launching QLA Server, set the Sleep control to Never in the Energy Saver control panel for the Server (→ System Preferences → Energy Saver). If your computer enters the low-power sleep mode, QLA Server cannot grant licenses, and you must restart the server.

STARTING QLA SERVER WHEN IT RUNS AS A SERVICE
You can run QLA Server as a service so that you do not need to start it manually every time you boot the computer.
ON MAC OS
You can run QLA Server as an automatic service that launches each time you restart your server.

ON WINDOWS
You can configure QLA Server to run as an automatic or manual service. If you configure QLA Server to run automatically, it launches each time you restart your server. If you configure QLA Server to run as a manual service, you must start the service each time you restart your server.

Before you launch QLA Server, set the System Standby to Never and Turn off hard disk to Never in Power Options (Start → Settings → Control Panel → Power Options). If your computer enters any of the above modes, QLA Server cannot grant licenses, and you must restart your server.

If you are running the server as a service, choose Start → Settings → Control Panel → Administrative Tools → Services. Select Quark License Administrator and click Start.


Alternatively, right-click My Computer on the desktop and select Manage → Computer Management → Services and Applications → Services.

ON SOLARIS
You can run QLA Server as an automatic service that launches each time you restart your server. To manually start QLA Server as a service without restarting the computer, log on as the root user and run the following command:

/etc/rc2.d/s12linkQLAServer

This action automatically launches files in the “rc3.d” folder and starts the server.

You can enable or disable the service on Mac OS and Solaris. To disable service when you restart the computer, double-click the “disableQLAService” file in the “Server” folder. To enable it, double-click the “enableQLAService” file in the “Server” folder.

STARTING THE BACKUP SERVER
When you install QLA, you must specify a backup server. Your primary server regularly sends a heartbeat signal to the backup. If the primary server stops sending heartbeat signals, the backup server automatically starts and monitors license usage until your primary server is available again.

After the primary server has re-established its connection to the backup server, the primary server once again begins to monitor license usage. At this point,
the backup server no longer grants licenses. QLA automatically merges the log files and configuration information for both servers, providing a continuous record of license usage.

If the primary and backup server are disconnected from each other for more than three days, the backup server stops granting licenses until the primary server is restored to the network.

LICENSE INFORMATION
When you launch QLA Server, information about your licensed Quark products displays. This information is available in the QLA Control Panel.

ACCESSING QUARK LICENSE ADMINISTRATOR
You must first install the QLA Control Panel to access QLA. For information about installing the QLA Control Panel, see the “Installation Instructions.pdf” file on the QLA CD-ROM.

If the QLA Control Panel is running on multiple computers, you can make changes to the license configuration in the QLA Control Panel from more than one computer.

LOGGING ON TO QLA CONTROL PANEL
MAC OS
To log on:

1 Open the “Client” folder inside the “Quark_License_Administrator” folder on your computer’s hard drive, then double-click the “QLAClient” file. Alternatively, you can double-click the “QLAClient” alias that is created on the desktop when you install the software. The QLA Control Panel Log-on dialog box displays.

QLA Control Panel Log-on dialog box

2 Enter your QLA User Name. This name is the one you entered when you installed QLA Server (or the name specified by your super administrator if you are a local administrator).
3 Enter your Password.

4 Click OK. The QLA Control Panel dialog box displays.

**WINDOWS**
To log on:

1 Choose Start → Programs → Quark License Administrator → QLA Client or double-click the “QLA Client” alias that was created on the desktop when you installed the software. The QLA Control Panel Log-on dialog box displays.

2 Enter your QLA User Name. This name is the one you entered when you installed QLA Server or (the name specified by your super administrator if you are a local administrator).

3 Enter your Password.

4 Click OK. The QLA Control Panel dialog box displays.

**CHANGING YOUR PASSWORD**
To change your password:

1 Choose Start → Programs → Quark License Administrator → QLA Client or double-click the “QLA Client” alias that was created on the desktop when you installed the software. The QLA Control Panel Log-on dialog box displays.

2 Enter your QLA User Name.

3 Click Change Password. The Change Password dialog box displays.

4 Enter your Old password.

5 Enter your New password.

6 Enter your new password again in the Confirm password field.

7 Click OK.

**LOGGING OFF OF THE QLA CONTROL PANEL**
To log off, choose System → Exit in the QLA Control Panel dialog box.
SHUTTING DOWN THE QUARK LICENSE ADMINISTRATOR SERVER COMPONENT

To shut down QLA Server, display the server window and click Stop Server. This action shuts down the server and associated applications completely.

SHUTTING DOWN WHEN THE SERVER RUNS AS A SERVICE

ON MAC OS
If you are running the server as a service on Mac OS, run the “stopQLAService” script located in the “Server” folder.

ON WINDOWS
If you are running the server as a service on Windows XP, choose Start → Settings → Control Panel → Administrative Tools → Services → Quark License Administrator → Stop to stop the service.

If you are running the server as a service on Windows 2000, choose Start → Settings → Control Panel → Administrative Tools → Services → Quark License Administrator → Stop to stop the service.


Alternatively, right-click the My Computer icon on the desktop, select Manage → Computer Management → Services and Applications → Services.

You can configure the service to run automatically or manually.

ON SOLARIS
If you are running the server as a service on Solaris, launch the “stopQLAService” script located in the “Server” folder.

To ensure that client activity does not interfere with the license file download process, Quark staff recommends you click Stop Server in the server window to shut down the server component each time you download a new license file.
UNDERSTANDING THE EMERGENCY KEY LAUNCH FEATURE FOR QUARK APPLICATIONS

If your QLA primary and backup servers are both unavailable, or if your entire network becomes disabled, you can use the Emergency Key Launch (EKL) feature to temporarily launch copies of Quark applications on your client computers. This capability gives you time to get your network or server running again.

If the primary and backup servers are unavailable when you attempt to launch a Quark application, the software displays the option to use EKL to launch the application. You can use EKL to run a Quark application without the servers for as many as 120 hours. If the Quark application is not connected to a QLA Server after 120 hours of EKL use, you will be unable to launch the application on the client computers.

After the Quark application has reconnected to the QLA server, EKL recharges itself, and you again have the ability to use EKL to operate the application for a maximum of 120 hours. The initial duration that you use the EKL functionality (1 to 120 hours) must allow adequate time for your Information Technology staff to rectify the issues regarding the inability of the Quark application to connect to a QLA Server.

The EKL capability is enabled only after your Quark application successfully connects to the QLA server at least once after installation of QLA.

The EKL duration limit is designed to protect your company from users who engage in software piracy. To ensure you have access to this functionality during emergency situations, you might want to define a company policy for the usage of EKL.

This functionality is available only for QuarkXPress 6.x and QuarkCopyDesk.

USING THE QLA SERVER INTERFACE

QLA Server is the software component that issues licenses to the Quark application clients.

To launch QLA Server, double-click the shortcut icon on the desktop, which is created automatically when you install the software. The QLA Server window displays.
QLA Server

This window contains the following components:

- The **Server Status** area
- The **Server Details** area
- The **Stop Server** button
- The **Refresh** button
SERVER STATUS (AREA)
This area contains the following components:

- **Serial Number**: Displays the registered serial number for each application.
- **Total Licenses**: Displays the number of licenses (runcount) that you have purchased for each application in the list.
- **Remaining Licenses**: Displays the number of licenses after the system distributes licenses to local administrators, who create pools and lists and reserve the licenses for their users. The number of licenses in use includes the number of licenses users have checked out and the number of extended check-outs users are using.

SERVER DETAILS (AREA)
The **Server Details** area displays QLA Server details, such as the date and time when QLA Server was started, the IP address and port number of the computer on which it is running, and whether the server is primary or backup. The icon indicates that QLA Server is running. The green color indicates that QLA Server is running on the primary server; yellow indicates that QLA Server is running on the back-up server.

STOP SERVER (BUTTON)
Click the **Stop Server** button to stop QLA Server.

REFRESH (BUTTON)
Click the **Refresh** button to update the data in QLA Server.

USING THE QLA CONTROL PANEL USER INTERFACE
Use the QLA Control Panel to create and update license files for freelancers, contractors, and other remote users; create local administrators; view the log file; create node-locked pools and lists; change configuration options; set e-mail notifications and make other e-mail-related settings; and view the information of licensed extensions associated with QuarkXPress 7.0 along with the check-out status.

To log on to the QLA Control Panel software, double-click the shortcut icon on the desktop, which is created automatically when you install the software. The **QLA Control Panel** dialog box displays.
The QLA Control Panel contains menus and tabs.

**MENUS**
The QLA Control Panel provides easy access to menus and their commands in a single window. Click the appropriate to perform various activities.

**SYSTEM MENU**
Use the System menu to update the data in the QLA Control Panel dialog box or exit the application.

- **Refresh**: Choose Refresh to update the data in the QLA Control Panel.
- **Exit**: Choose Exit to close the QLA Control Panel.
UTILITIES MENU
Use the Utilities menu to generate a remote license file for freelance users. Use this menu to update the remote license file when necessary.

- **Generate Remote License File**: Choose Generate Remote License File to generate a remote license file for freelance users.
- **Update Remote License File**: Choose Update Remote License File to update information in a remote license file.

VIEW MENU
Use the View menu to view XTensions module information, emergency key and system logs, specify log options, and the extended or future check-out status of available licenses.

- **XTension Information**: Choose XTension Information to view your XTensions modules and the licenses associated with them.
- **Emergency key log**: Choose Emergency key log to view the emergency key log for the selected application licenses.
- **System Log**: Choose System Log to view information about license usage among the Quark applications that are using QLA.
- **Log Options**: Choose Log Options to define the activities to monitor through QLA.
- **Extended Status**: Choose Extended Status to view the extended check-out status of Quark applications.
- **Check-out Status**: Choose Check-out Status to view the check-out status of Quark applications.
- **Future Extended Status**: Choose Future Extended Status to view the licenses that will be checked out in future.
ABOUT MENU
Use the About menu to view information about the current version of QLA Control Panel.

TABS
Tabs in the QLA Control Panel provide various options for creating administrators, pools, or lists and defining settings for e-mail notifications.

LICENSE NODES TAB
Click the License Nodes tab to create local administrators, view the information for various licenses, and create pools and lists of users.

License Nodes tab

The License Nodes tab consists of the following elements:

- Admin Hierarchy (area): Displays the hierarchy of users, such as super administrator and local administrators. You can create, edit, and delete admin users in this area.

- License File Application Information (area): Displays information about your licensed Quark products.
• **License Distribution** (area): Displays the allocation of licenses to various users based on pools and lists to meet their needs.
• **Add** (button): Click **Add** to create a node-lock pool or list.
• **Edit** (button): Click **Edit** to edit a node-lock pool or list.
• **Delete** (button): Click **Delete** to delete a node-lock pool or list.

**USER PARAMETERS TAB**

Click the **User Parameters** tab to view the available auxiliary licenses and accept them for use, view the license keys for the selected application, define the e-mail server, and add, edit, or delete multiple e-mail addresses for the system administrator.

**User Parameters** tab

The **User Parameters** tab consists of the following elements:

• **License Configuration** (area): Displays information about your auxiliary licenses. You can accept an auxiliary license for use in this area.
  
  To view the license keys associated with the selected application, click **License Keys**.

• **Site Information** (area): Use this area to enter the **E-mail Server Name** and **System Admin Email Address**. Click **Add**, **Edit**, or **Delete** to add, edit, or delete e-mail addresses.
Click the **Configuration Options** tab to specify heartbeat settings for the QLA Server and enter the extended check-out configuration values.

The **Configuration Options** tab consists of the following elements:

- **Server Configuration** (area): Use this area to enter the **Heartbeat Interval (Seconds)** and **Heartbeat Retries**.

- **Extended check-out configuration** (area): Use this area to enter the **Extended Heartbeat Interval (Seconds)** and the **Maximum extended check out for free run count (days)**.

- **Save** (button): Click Save to save the changes.

- **Reset** (button): Click Reset to clear the fields.
E-MAIL NOTIFICATION TAB

Click the E-mail Notification tab to specify when e-mail notifications for QLA Server are sent, define license usage, and configure expiration of license files.

E-mail Notification tab

The E-mail Notification tab consists of the following elements:

- **License Usage Notification** (area): Use this area to Enable License Usage Notification and enter the License Usage threshold (percentage) and License Usage Notification Interval (Hours).
- **Server Status Notification** (area): Use this area to enable primary and backup server notifications.
- **License File Expiration Notification** (area): Use this area to configure the system to send an e-mail notification a specific number of days before the license expiration date.
- **Enable Application Expiration Notification** (area): Use this area to Enable Application Expiration Notification and view information about the Quark application.
- **Save** (button): Click Save to save the changes.
- **Reset** (button): Click Reset to clear the fields.
Chapter 2: Specifying Quark License Administrator Settings

The QLA Control Panel contains the interface for QLA. When you log on, the QLA Control Panel dialog box automatically displays to give you access to all your license activities.

VIEWING LICENSE FILE INFORMATION AND ASSIGNMENTS

The License Nodes tab in the QLA Control Panel dialog box contains three areas: the Admin Hierarchy area, the License File Application Information area, and the License Distribution area. The Admin Hierarchy area displays the hierarchy of users, such as your super administrator and local administrators. The License File Application Information area displays information about your licensed Quark products. Use the License Distribution area to define how licenses are allocated to meet your needs.

VIEWING ADMIN HIERARCHY

Use the Admin Hierarchy area to view the super administrator, the list of local administrators, and the list of local sub-administrators.

For more information about local administrators, see “Monitoring Multiple Administrators” in Chapter 3, “Administering Licenses.”

To view the complete Admin Hierarchy area, log on to QLA with the user name and password you entered while installing QLA Server. Click the License Nodes tab in the QLA Control Panel dialog box to display the Admin Hierarchy area, which displays the following information:

- Identity of the super administrator (at the top of the list)
- Identities of the local administrators (located under the super administrator and represented by disclosure boxes or nodes)
VIEWING LICENSE FILE INFORMATION

Use the License File Application Information area to view the list of Quark applications you are managing with QLA.

The License File Application Information area displays in the upper-right corner of the License Nodes tab.

License Nodes tab

This area contains the following columns:

- **Application**: Displays the Quark applications that are managed by QLA.
- **Serial Number**: Displays the registered serial number for each application.
- **Version**: Displays the version number for each application.
- **Expiration**: Displays the expiration date of the licensed serial number. If the word “Perpetual” displays in the Expiration column, that serial number does not expire.
- **Licenses**: Displays the number of licenses (runcount) that you have purchased for each application in the list.
- **Remaining Licenses**: Displays the number of licenses that remain after the system distributes licenses to local administrators, who create pools and lists and reserve the licenses for their users.
**VIEWING LICENSE ASSIGNMENTS**

When you select an application in the License File Application Information area, the License Distribution area displays information about how that application’s licenses are distributed. This area displays information under the following columns:

- **Pool/List Name**: Displays the name you have assigned to the pool or list.
- **Type**: Displays whether the group is a node-lock pool or a node-lock list.
- **Allocation**: Displays how many of the total runcount licenses are in the group.
- **User Names**: Displays the names of the users in the pool or list, separated by semicolons.
- **Host IDs**: Displays the physical hardware addresses for the computers in the pool or list.

The **User Names** column displays the names of users as specified while logging on to their computers.

**VIEWING XTENSIONS LICENSES ASSOCIATED WITH QUARKXPRESS**

Use the XTensions Information submenu in the View menu to view the information for XTensions module licenses that are associated with QuarkXPress.

Choose View → XTensions Information to display the XTension Information dialog box.

![XTension Information dialog box](image)
This dialog box displays the following columns:

- **XTensions**: Displays the name of the XTensions module.
- **Version**: Displays the version of the XTensions module.
- **Serial**: Displays the serial number of the XTensions module license.
- **XTDeveloper**: Displays the name of the developer who created the XTensions module.
- **Total Runcount**: Displays the total number of XTensions module licenses.
- **Remaining Runcount**: Displays the number of remaining licenses.

**USING THE USER PARAMETERS TAB**

Use the User Parameters tab of the QLA Control Panel dialog box to view information about each application’s auxiliary license configuration and the e-mail server name.

![QLA Control Panel](image)

**User Parameters** tab in the QLA Control Panel dialog box

This tab contains the License Configuration area and the Site Information area.
LICENSE CONFIGURATION (AREA)
The License Configuration area displays information about your eligibility for auxiliary licenses. This area contains the following columns:

- **Application**: Displays the Quark applications that are using QLA.
- **Serial Number**: Displays the registered serial number for each application.
- **Version**: Displays the version number for each application.
- **Aux. Licenses**: Displays the total number of auxiliary licenses available for each application. For more information about auxiliary licenses, see “Increasing Runcount using the Auxiliary Pool” in Chapter 3, “Administering Licenses.”
- **Aux. Duration**: Displays the length of time an auxiliary license remains active after check-out.
- **Accept**: Displays the number of auxiliary licenses available for use. This value overrides the Auxiliary License value in the License Nodes tab, and you may use this value to limit the number of extra licenses used.

Click License Keys to display the License Keys dialog box. Use this dialog box to view information about license keys that are configured for the selected application.

UNDERSTANDING LICENSE KEYS
License keys are application-specific data that are stored in the license file. The information might be in the license file when you download it, or it is added by an application such as QuarkXPress, QuarkDDS, or Quark Digital Media Server when you run QLA.

When a user checks out a license, the application queries these license key values and uses them to tailor application features accordingly. For example, Quark Digital Media Server may add a license key that specifies the maximum number of database connections per user. Each time a user makes a connection, Quark Digital Media Server checks the license key value. If the user exceeds the connection limit, Quark Digital Media Server displays an alert.

If the application you select has no license keys associated with its serial number, an alert displays. Click OK to close the alert.

LICENSE KEYS (DIALOG BOX)
Use the License Keys dialog box (User Parameters tab) to view information about the selected application’s license keys. Different applications have different licensing requirements and user configurations, which means that this dialog box can display different information for each application that you monitor with QLA.
Although you cannot edit values that are provided by Quark in the license file, you might be able to change some of the license key values that are set by the application at runtime.

To change the permitted number of database connections per user in the License Keys dialog box:

1. Select an application in the User Parameters tab and click License Keys. The License Keys dialog box displays.

2. Select the field to edit. If it is editable, change the value and click OK.

![License Keys dialog box](image)

The application might or might not accept the new value, depending on the nature of the change you have made.

**SITE INFORMATION (AREA)**

Use the Site Information area (User Parameters tab) to specify the name of the e-mail server you use to communicate with Quark. This server must be a valid SMTP server. To change the server, enter a new server name in the E-mail Server Name field, then click Set.

The Site Information area also lists the system administrator e-mail addresses.

**ADDING AN E-MAIL ADDRESS**

To add an address to the list:

1. Click Add in the Site Information area. The Add an E-mail Address dialog box displays.

2. Enter the address in the E-mail Address field, then click OK.
The address is added to the **System Administrator E-mail Address** field in the **Site Information** area.

Separate the e-mail address entries with semicolons to enter multiple e-mail entries in the Add an E-mail Address dialog box.

**EDITING AN E-MAIL ADDRESS**
To change an e-mail address:

1. Select the address in the **Site Information** area, and click **Edit** to display the **Edit an E-mail Address** dialog box.

2. Edit the address, then click **OK**.

**DELETING AN E-MAIL ADDRESS**
To delete an existing e-mail address, select the address in the **Site Information** area, click **Delete**, then click **OK**.

**CONFIGURING QUARK LICENSE ADMINISTRATOR**

Use the **Configuration Options** tab in QLA Control Panel dialog box to define how the server will monitor the licenses.

Configuration Options tab

This tab contains the **Server Configuration** area and the **Extended Check-out Configuration** area.
SERVER CONFIGURATION (AREA)
The Quark applications administered by QLA poll the server periodically to ensure there is a valid connection. Because this polling session takes place periodically and determines the ability of the application to keep running, it is called a heartbeat. Use the Server Configuration area to define the heartbeat interval.

To specify settings for the heartbeat:

1. Enter the number of seconds between each polling session in the Heartbeat Interval (Seconds) field.

   If the Quark application fails to successfully connect to the server, it automatically attempts to reconnect.

2. In the Heartbeat Retries field, enter the number of times the client must reattempt to make the connection before reporting an error and failing.

   For example, if your Heartbeat Interval (Seconds) value is 3600 (one hour) and the Heartbeat Retries value is 10, the system waits 10 hours before failing. If the client is able to successfully connect with the server on or before its tenth attempt, outstanding licenses are restored. If not, all allocated licenses are checked in.

Remember that the Heartbeat Interval (Seconds) value represents the number of seconds between attempts by the client to reach the server. Although a short interval ensures that a break in the connection between server and client is detected early, network traffic might be significantly slower if the interval is too short. A large number means less traffic, but it also creates the possibility of the server neglecting to notice that the client is absent. You should plan your installation according to your environment’s needs. If the clients are disconnected from the server, the server uses the heartbeat mechanism to reconnect to clients that were using licenses at the time of the disconnection. Until the server receives a heartbeat from all the clients that checked-out licenses, the licenses remain in the recovery pool. If the server does not receive a heartbeat from a client that was previously connected, that client’s licenses are checked in to their regular pool or list.

EXTENDED CHECK-OUT CONFIGURATION (AREA)
Extended licenses are for users who want to temporarily work on a computer that is not connected to the network (for example, on a laptop). Use the Extended Check-out Configuration area to define the settings for extended licenses.
To define the settings for extended licenses:

1. Enter the number of seconds between each polling session in the **Extended Heartbeat Interval (Seconds)** field.

2. In the **Maximum extended check out for free run count (days)** field, enter the maximum number of days users can check out the extended license.

For information about checking out extended licenses, see “Using Extended Licenses” in Chapter 3, “Administering Licenses.”

Extended licenses are available only for QuarkXPress and QuarkCopyDesk.

### CONFIGURING E-MAIL NOTIFICATIONS

Use the **E-mail Notification** tab of the QLA Control Panel dialog box to configure periodic notifications for system administrators and application users.

![QLA Control Panel](image_url)

**E-mail Notification** tab
This tab contains the License Usage Notification area, the Server Status Notification area, the License File Expiration Notification area, and the Enable Application Expiration Notification area.

LICENSE USAGE NOTIFICATION (AREA)
You need to keep a track of the licenses that are in use as well as those that are unused. This tracking keeps you informed about the availability of licenses at all times and prevents a situation in which licenses are unavailable for users. To facilitate this tracking, you can configure the license usage notifications to be sent to you (the QLA Administrator) in the License Usage Notification area.

To configure license usage notifications:

1. Check Enable License Usage Notification.
2. Enter a value between 0 and 100 in the License Usage Threshold (Percentage) field. This value is the percentage of license usage at which the notification is sent to you.
3. Enter a value between 0 and 100 in the License Usage Notification Interval (Hours) field. This value is the number of hours between notifications sent to you.

SERVER STATUS NOTIFICATION (AREA)
If you have installed both primary and backup servers, use the Server Status Notification area to configure the QLA Control Panel to generate a notification when either of the servers is unavailable.

<table>
<thead>
<tr>
<th>License Usage Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable License Usage Notification</td>
</tr>
<tr>
<td>License Usage Threshold (Percentage)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Server Status Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Primary Server Notification</td>
</tr>
<tr>
<td>Enable Backup Server Notification</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>License File Expiration Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your license file is valid on till</td>
</tr>
<tr>
<td>Send me the notification mail before days</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enable Application Expiration Notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
</tr>
<tr>
<td>-------------</td>
</tr>
<tr>
<td>QuarkXPress</td>
</tr>
</tbody>
</table>

Server Status Notification area
Check one or both of the following options:

- Check **Enable Primary Server Notification** to enable the Control Panel to generate a notification when the Primary Server is unavailable.
- Check **Enable Backup Server Notification** to enable the Control Panel to generate a notification when the Backup Server is unavailable.

**LICENSE FILE EXPIRATION NOTIFICATION (AREA)**

If users are using a “time-bombed” license file (one that is close to expiring), use the number of days in the **License File Expiration Notification** area to send them notifications of the license expiration before it occurs.

Check **Send me the notification mail before days**, then enter the number of days before the expiration date when the notification should be sent to the user.

**ENABLE APPLICATION EXPIRATION NOTIFICATION (AREA)**

If some users have copies of time-bombed Quark applications, use the **Enable Application Expiration Notification** area to configure the QLA Control Panel to generate a notification regarding the expiration of the copies.

- Check **Enable Application Expiration Notification**.
- In the **No. of days before to notify** field, enter the number of days before the license copy expires that the notification must be sent.

For more information about various notifications and alerts the system generates, see Chapter 4, “Notifications and Alerts”.

The system generates these notifications and alerts only if you enter your e-mail server name in the **E-mail Server Name** field in the **User Parameters** tab of the QLA Control Panel.
Chapter 3: Administering Licenses

After you are familiar with the QLA Control Panel and have configured your system settings, you can begin defining the license allocation parameters for your system. You can create local administrators, assign users and computers to the various license pools, and view information about in-house, extended, and auxiliary license usage.

**MONITORING MULTIPLE ADMINISTRATORS**

The concept of multiple administrators enables superior management of licenses among different departments in your organization. Multiple administrators are especially helpful in an environment in which companies share their total resources among a number of departments, but the usage of resources does not follow any specific plan. In such environments, some departments might fall short of resources while others have more than they need. To avoid this issue, companies can divide their total resources among local administrators who head different departments. Local administrators are controlled by the super administrator. With this setup, every department administrator has a fair idea of the resources allocated to his or her department, which helps keep the system running smoothly as a whole. This division of resources also helps create a decentralized system of license management in which local administrators can allocate licenses to users in their respective groups as necessary.

The system administration is set up as a hierarchy, with the super administrator at the top, local administrators under the super administrator, and sub-administrators under the local administrators. Super administrator can create multiple local administrators and grant them licenses. The local administrators manage licenses for users under them. Local administrators can further create local sub-administrators for their domain and allocate them licenses for distribution. However, they can only assign licenses from within the quota of licenses that the super administrator grants them.

**CREATING LOCAL ADMINISTRATORS**

In the QLA Control Panel, a super administrator — a designation specified during QLA Server installation — can create multiple local administrators. Only the super administrator can create local administrators.
To create a local administrator:

1. In the **Admin Hierarchy** area (QLA Control Panel dialog box → **License Nodes** tab), right-click super administrator.

2. Choose **Create Admin User** from the context menu. The **Create Admin User** dialog box displays.

3. Enter the name of the local administrator in the **User Name** field.

4. Check **User Lock** to protect the local administrators’ configurations.

To give local administrators full autonomy in allocating runcounts to the users in their groups, check **User Lock**. This option protects their settings and ensure that you do not accidentally delete their ability to allocate runcounts; create, edit, and delete pools and lists; and create and edit sub-administrators within their groups. Under specific circumstances, you can delete local administrators. Locking or unlocking a local administrator automatically locks or unlocks all the sub-administrators under that local administrator.
5 Enter the local administrator’s password in the **Password** field.

6 Enter the password in the **Confirm Password** field to confirm that the password you assigned is correct.

The **Application Information** area displays the application information and usage information of the Quark product licenses.

- **Appl Name**: Displays the name of the application.
- **Serial Number**: Displays the license serial number of the application.
- **Total RunCount**: Displays the runcount available to the you for the serial number of the application.
- **Remaining RunCount**: Displays the runcount you can assign among the local administrators.
- **Assigned RunCount**: Displays the runcount that you have assigned to a local administrator. By default, assigned runcounts are zero. To change the runcount that you assign to the local administrator, click ✖️.

7 Click Create.

Local administrators can launch the Control Panel Client and log on with their user names and passwords to further manage the allocated licenses. After successfully logging on, they can see the sub-administrators (if any) in their domain. The license file contains the number of licenses owned by the local administrator.

**EDITING LOCAL ADMINISTRATORS**
Both the super administrator and local administrators can modify local administrator settings, depending on your system settings.

To edit a local administrator:

1 In the **Admin Hierarchy** area (QLA Control Panel dialog box → License Nodes tab), right-click the selected local administrator.

2 Choose **Edit Admin User** from the context menu. The **Edit Admin User** dialog box displays.

3 Check **User Lock** to prevent the super administrator from modifying your information.
Checking **User Lock** prevents the super administrator from making changes to your settings. As a local administrator, checking **User Lock** for your account prevents your super administrator from changing the runcounts allocated for different serial numbers; modifying your pools and lists; and creating or editing sub-administrators in your domain (your account and your sub-administrators’ accounts). However, the super administrator can delete your account, regardless of whether you check **User Lock**. If **User Lock** is unchecked, the super administrator can make changes to your account.

4 In the **Application Information** area, click to change the information in the **Assigned Runcount** column of the selected Quark application.

   Repeat step 4 until you make all of the necessary changes in the runcount value of the Quark applications.

5 Click **Save**.

**DELETING LOCAL ADMINISTRATORS**

Super administrators can delete a local administrator when no licenses are checked out from that local administrator’s domain.

To delete a local administrator:

1 In the **Admin Hierarchy** area (QLA Control Panel dialog box → **License Nodes** tab), select the local administrator to delete.

2 Choose **Delete User** from the context menu. The **Delete Confirmation** dialog box displays.

3 Click **OK**.

**RESETTING FORGOTTEN PASSWORDS**

Local administrators and sub-administrators can reset their forgotten passwords using the QLA administrator’s password, which acts as the master password.

To reset a password:

1 Log on to the QLA Control Panel Client using the local administrator user name and the QLA administrator password.

2 Click **Change Password** to reset the password for the account.

3 Enter your **User Name**.

4 Enter **Old password** for the QLA administrator.

5 Enter your **New password**.

6 Enter the new password in the **Confirm password** field.

7 Click **OK**.
ALLOCATING LICENSES

QLA provides you flexibility while allocating licenses among users. You can assign a license to a specific individual or to a computer. You can also assign a license or a number of licenses to a group. For information about the types of licenses that you can assign, see “Understanding License Types” in the “Introduction” chapter of this user guide.

USING THE RUNCOUNT POOL

When you purchase your Quark application, you request a specific number of licenses, called a runcount.

By default, the runcount pool is the total number of licenses you purchased for your Quark application. If you log on as a local administrator, the runcount pool is the number of licenses allocated to you by your super administrator. As you assign licenses to other lists or pools, they are removed from the runcount pool. Licenses from the runcount pool are granted on a first-come, first-served basis to the users or computers that are not assigned to node-lock lists or node-lock pools.

You can view the number of licenses (the runcount) you purchased for your Quark applications or the number of licenses the super administrator has allocated to you in the Licenses column (License Nodes tab) of the QLA Control Panel dialog box.

CREATING A NODE-LOCK LIST OR A NODE-LOCK POOL

A node-lock list is a registry of specific users or computers. This list assigns a one-to-one correspondence between the number of users or computers in the list and the number of licenses allocated to the list. A node-lock pool is a group of users and computers that share a specified number of licenses; the pool can contain more members than licenses.

Use the QLA Control Panel dialog box to easily create a node-lock list or pool:

1. In the License Nodes tab (QLA Control Panel dialog box), select the Quark application for the new node-lock list or pool.
2. Click Add. The Add License Distribution dialog box displays.
Add License Distribution dialog box

You cannot delete a user if that user has checked out a license.

View the Licensed Application area to confirm that you selected the correct application in the License Nodes tab of the QLA Control Panel dialog box.

3 Enter a name for the pool or list in the Pool/List Name field in the Custom Configuration area.

4 To create a node-lock pool, check Make This a Node Lock Pool. If you leave this option unchecked, QLA creates a node-lock list.

5 Enter the number of licenses to assign to the pool in the Pool Count field.
6 Check Permit Extended License Checkout to allow users and computers to check out extended licenses in the pool or list. When Permit Extended License Checkout is checked, the Maximum Duration field is available. Enter the maximum number of days users or computers can check out an extended license.

7 Click Add in the User Names or Host IDs area to display the Add user name or Add host ID dialog box. Enter the names of individual users or the IP address of machines that run the application, then click OK.

<table>
<thead>
<tr>
<th>Add host ID</th>
<th>Add user name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add host ID dialog box" /></td>
<td><img src="image" alt="Add user name dialog box" /></td>
</tr>
</tbody>
</table>

Add host ID and Add user name dialog boxes

Continue to enter the user names and host IDs until you have added all of the potential users to the list or pool, then click OK.

When adding a user to a node-lock list or a node-lock pool, the name you enter in the Add user name dialog box must be the name the user enters to log on to his or her computer. On Mac OS, this name is the Computer Name as specified in the Sharing system preference. On Windows, this name is the user name specified for the network.

If the Add button is unavailable, no more licenses are available in the runcount pool.

To create a pool for a local administrator, select the local administrator in the Admin Hierarchy tree. Select the serial number, then create the pool or list.

EDITING A NODE-LOCK LIST OR A NODE-LOCK POOL

After you have created a node-lock list or a node-lock pool, you can edit the list of members. You can also change a list to a pool or a pool to a list:

1 In the License File Application Information area (QLA Control Panel dialog box → License Nodes tab), select the application with the node-lock list or pool to edit. This action activates the License Distribution area for the application.

2 In the License Distribution area, select the list or pool to edit, then click Edit. The Edit License Distribution dialog box displays. Alternatively, double-click the list or pool to display the Edit License Distribution dialog box.
3 Make the appropriate modifications, then click OK.

DELETING A NODE-LOCK LIST OR A NODE-LOCK POOL
You can quickly remove a node-lock list or a node-lock pool from your license configuration:

1 In the License File Application Information area (QLA Control Panel dialog box → License Nodes tab), select the application with the node-lock list or pool to delete. This action activates the License Distribution area for the application.

2 In the License Distribution area, select the list or pool in the Pool/List Name column that you want to remove, then click Delete.

The Delete button is disabled when a member of the selected list or pool has checked out a license.

To delete a pool for a local administrator, select the local administrator in the Admin Hierarchy area. Select the serial number in the pool or list, then delete it.
WORKING WITH REMOTE LICENSE FILES

Use QLA to run Quark applications at any remote location using remote license files. Granting this type of license is helpful when users cannot connect to the network — for example, freelancers, contractors, or employees often work while traveling. In such cases, you can provide these users with customized license files that work for a specific duration. The remote license file is customized with all the necessary information for running the application, including the IP address, the physical address of the freelancer’s computer, and the expiration date of the license file. When you use this file at a remote location, Quark applications do not search for the QLA server because the remote license file already all the relevant information.

GENERATING A REMOTE LICENSE FILE

To generate a remote license file:


2. From the Select Serial Number drop-down menu (Application Information area), choose the serial number of the application for which to create the remote license file.
3 Choose the **Application Name** and **Version** based on the application’s serial number.

The **File Name** field displays the name of the remote license file that you are generating. This name displays according to the option you select in the **Application Name** and **Version** fields.

4 In the **Days** field, enter the number of days for which you are issuing the remote license file. After this duration, the remote license file expires, and the runcount is checked in automatically.

You cannot enter a number of days that exceeds the maximum duration specified in the following areas:

- **Configuration Options**: If the user belongs to global runcount pool.
- **Pool or List Configuration**: If the user belongs to that pool or list.

5 In the **Host ID** field (**User Details** area), enter the Mac address or the physical address of the freelancer’s computer (for example 000802439X12) or the 16-digit Firewire address.

To obtain the physical address, choose ⚙️ → **System Preferences** (Mac OS) or run the `ipconfig/all` command (Windows).

Remote license files run only on the computer for which the details are defined in the file.

6 Enter the freelancer’s computer name in the **User Name** field.

7 Enter the freelancer’s computer date (mm/dd/yyyy) in the **Start Date** field using the Calender control.

The user system date defines the date the user will start using the remote license file. The countdown for the time left before expiration of the remote license file starts from this date.

While using a remote license file, adjusting the system time might result in the expiration of the remote license file, even before the completion of the allocated time. In addition, if you try to use the application before the date and time specified in the remote license file, QLA marks the file as having been tampered with.
8 Click the **E-mail Notification** tab. Check **Generate Notification before expiration date** to generate a notification for the user regarding the time remaining before the license expires.

9 Enter the e-mail address of the user to whom the notification will be sent in the **E-Mail Id** field.

10 Enter the number of days before the file expires that QLA needs to send the notification in the **Number of days before expiration** field.

11 Click the **XTensions** tab. Check the **Include** check boxes of the appropriate XTensions modules to include the XTensions module information in the remote license file.
Click **Create** to generate the remote license file at the specified location. The **Open** dialog box displays. Enter the path or browse to the location to save the remote license file.

The local administrator must e-mail the generated license files to the Quark application user. The user needs to copy the files into the application’s installation directory before launching the application.

On the server, check-out days are measured in calendar days. When an extended license expires, the server checks it in at 12:01 a.m. on the expiration date. For example, if the expiration date is June 2, the license is checked in to the runcount pool at 12:01 a.m. on June 2. On the client, however, check-out days are measured in 24-hour periods. If the license was checked out at 4:00 p.m. on June 1 for a length of one day, the server adds the license back to the runcount pool at 12:01 a.m. on June 2, but the license can also be used on the remote computer until 4:00 p.m. unless the user manually checks it in before that time.

If a user must use the license beyond the duration specified in the remote license file, you can renew the license file or create another one.
GENERATING REMOTE LICENSE FILES FOR USE IN THE FUTURE
You can generate license files to be used in the future by specifying future dates for the start and end dates. Information for licenses to be checked out by users in the future displays in the **Future Request for Extended Licenses** dialog box (View → Future Extended Status).

![Future Request for Extended Licenses dialog box](image)

**Future Request for Extended Licenses** dialog box

Once the user starts using a license that is checked out for future use on the specified date, information related to it shifts to the **Extended Licenses Checked Out** dialog box (View → Extended Status). It no longer displays in the **Future Request for Extended Licenses** dialog box (View → Future Extended Status).

To generate a license file to be used in the future, specify a future start and end date using the Calendar control in the **Generate Remote License File** dialog box (Utilities → Generate Remote License File).

MODIFYING A REMOTE LICENSE FILE
You can modify a remote license file. For example, a freelancer might need more time to complete a project, or you might need to add the XTensions module information — without connecting to the QLA server. To extend the existing license duration, you can modify the same license file instead of issuing a new one.
To modify a remote license file:

1. Choose **Utilities → Update Remote License File**. The **Update Remote License File** dialog box displays.

2. In the **Remote License File** field (**Remote License File Location** area), locate the remote license file. Remote License file information displays in the relevant fields.

3. Modify the number the days to issue the remote license file in the **Days** field.

4. Click the **XTensions** tab. Check the **Include** check boxes of the appropriate XTensions modules to include the XTensions module information in the remote license file.

To check in the checked-out license through a remote license file, the user must connect to the QLA server network. The rest of the procedure is similar to checking in an extended license.

To update a remote license file, you must update it before the expiration date. Also, the QLA server must have the license information. To verify whether the server has the license information, check for the entry in **View → Extended Status** or **View → Future Extended Licenses**.
WORKING WITH EXTENDED LICENSES

Use the extended license pool when a computer using a licensed Quark application or an XTensions module associated with QuarkXPress must be removed from the network for a period. You can also allow users to check out an extended license so that they do not need to connect to the QLA server each time they launch their Quark applications. To allow users to check out XTensions modules, they must be loaded in the “XTension” folder of QuarkXPress.

An extended license user or computer can be a member of any list or pool (except the auxiliary pool) as long as the list or pool permits extended license usage. When a user or computer requests an extended license, QLA removes the license from the corresponding pool and add it to the extended pool for the duration of the time it is checked out.

You define which pools allow extended license check-out and the maximum number of days that an extended license can be checked out. When checking out a license, users specify how many days to check it out (not to exceed the limit you set).

To determine whether a list or pool permits extended license check-out, select the list or pool in the License Distribution area (QLA Control Panel dialog box → License Nodes tab), then click Edit. If Permit Extended Checkout is checked, the pool permits extended check-out.

Extended licenses are available only for QuarkXPress and QuarkCopyDesk.

CHECKING OUT AN EXTENDED LICENSE FOR QUARKXPRESS

Perform this task from the client computer. If you’d prefer, users can perform this task without intervention from you.

To check out an extended license for QuarkXPress:

1. Choose Utilities → Check Out License. The Check Out License dialog box displays.
2. In the Check Out License dialog box, enter the number of days the user is checking out the license.
3. Check Warn me and enter the numbers of days before expiration for the system to send an e-mail notification to the user that the license is about to expire. You can specify this length of time in days, hours, or minutes.
4. Click Check out. This option designates the license as an extended pool license.
On the server, check-out days are measured in calendar days. When an extended license expires, the server checks it in at 12:01 a.m. on the expiration date. For example, if the expiration date is June 2, the license is checked in to the run-count pool at 12:01 a.m. on June 2. On the client, however, check-out days are measured in 24-hour periods. If the license was checked out at 4:00 p.m. on June 1 for a length of one day, the server adds the license back to the run-count pool at 12:01 a.m. on June 2, but the license can also be used on the remote computer until 4:00 p.m. unless the user manually checks it in before that time.

If a user must use the license beyond the duration specified in the remote license file, you can renew the license file or create another one.

When you perform an extended check out for QuarkXPress, all the licensed XTensions modules loaded with the application at that time also have an extended check out and are available locally with QuarkXPress.

CHECKING IN AN EXTENDED LICENSE FOR QUARKXPRESS

You or your users can check in an extended license manually from the client computer, or you can allow the license to expire. The disengaged computer monitors the duration of the check-out. If the license is not checked in after the specified time span, the license expires, and the Quark application does not launch. On the network, the server maintains the extended licenses, ensuring that any licenses not checked in manually are checked in to their respective pools at expiration.

MANUALLY CHECKING IN A LICENSE

Encourage users to check in their extended licenses as soon as they are finished using them so that the licenses are available for other users in the node-lock list or node-lock pool. Users can check in licenses without intervention from you.

To check in an extended license from QuarkXPress:

1 Choose Utilities → Check In License. The Check In License dialog box displays, indicating the number of days left in the extended license.

2 Click Check In. This action also checks in the licenses of the XTensions modules.

VIEWING INFORMATION ABOUT EXTENDED POOL LICENSES

Use the QLA Control Panel dialog box to display a list of licenses that are checked out or scheduled to be checked out through the QLA Control Panel dialog box. Choose View → Extended Status. The Extended Licenses Checked Out dialog box displays the licenses that are checked out by users in the extended pool. If you are a super administrator, you can view all the checked-out licenses. Local administrators can view all the global runcount licenses and the licenses
checked out from pools or lists belonging to their domain, including those in their sub-administrators’ pools and lists.

**Extended Licenses Checked Out dialog box**

This dialog box contains the following columns:

- **Application**: Displays the application for which a license is checked out.
- **Version**: Displays the version of the application.
- **Serial**: Displays the serial number of the license that is checked out.
- **User**: Displays the name of the user who has checked out the license.
- **Pool Type**: Displays the type of pool the license is configured for.
- **Pool List Name**: Displays the name of the pool or list.
- **Start Date**: Displays the date on which the license was checked out.
- **Expiration**: Displays the date the extended license will expire.
- **Included XTension**: Displays the number of XTensions modules associated with QuarkXPress.

To update the data in the **Extended Licenses Checked Out** dialog box, click **Refresh**.

Extended licenses are available only for QuarkXPress and QuarkCopyDesk.
INCREASING RUNCOUNT USING THE AUXILIARY POOL

If you need more licenses than you have purchased and you do not have time to order for more, you can use licenses from the auxiliary pool.

When you use a license from the auxiliary pool, you are agreeing to purchase another license. When you use an auxiliary license, an e-mail message is sent to Quark and your accounting department. Quark will then bill you for the additional licenses.

For auxiliary license usage guidelines and information about qualifying for auxiliary licenses, contact your Quark representative.

Only super administrators can accept auxiliary licenses. You cannot create pools and lists for auxiliary licenses.

CONFIGURING AN AUXILIARY LICENSE

To configure an auxiliary license:

1. Open the QLA Control Panel dialog box and click the User Parameters tab.

License Configuration area (QLA Control Panel → User Parameters)
2 In the **License Configuration** area, select the application that requires the auxiliary license and click 🔄. The **Auxiliary License Acceptance** dialog box displays.

3 Enter the number of auxiliary licenses to purchase and click **OK**.

The value you enter cannot exceed the value in the **Aux. Licenses** column of the **User Parameters** tab. If users have already checked out auxiliary licenses, you cannot set this value to a number that is less than the number of checked-out auxiliary licenses.

4 Click **OK** in the alert that displays to remind you that you will be billed for the additional licenses.

In the **User Parameters** tab, the **Accept column** updates to reflect the new number of auxiliary licenses in use.

If you are not eligible for the number of auxiliary licenses you enter in the **Auxiliary License Acceptance** dialog box, QLA displays your maximum allowable number of auxiliary licenses.

You do not need to take any special steps to acquire an auxiliary license. If the Auxiliary License Acceptance dialog box displays available licenses, an auxiliary license is automatically granted if all other licenses are in use for a Quark application when an additional user launches that application.

---

### VIEWING LICENSE CHECK-OUT STATUS

You can display the list of licenses that are checked out for your applications at any time. The **Licenses Checked Out** dialog box displays a list of your applications, the names of the users who checked them out, and the IP address and port number they are checked out to. The super administrator can view all the checked-out licenses. Local administrators can view all global runcount licenses and the licenses checked out from pools and lists belonging to their domain (local administrators’ and all their sub-administrators’ pools and lists).

Choose **View → Check Out Status** (Control+K on Mac OS, Ctrl+K on Windows) to display the **Licenses Checked Out** dialog box.
Licenses Checked Out dialog box

This dialog box displays the following columns:

- **Application**: Displays the application for which a license is checked out.
- **Version**: Displays the version of the application.
- **Serial**: Displays the serial number of the checked-out license.
- **User Name**: Displays the name of the user who checked out the license.
- **Pool Type**: Displays the type of pool the license is configured to.
- **Pool List Name**: Displays the name of the pool.
- **IP Address: Port**: Displays the IP address and port number for the computer using the license.
- **Included XTensions**: Displays the XTensions modules associated with the applications.

To update the data in the Licenses Checked Out Status dialog box, click **Refresh**.
MONITORING LICENSE ACTIVITIES THROUGH THE SYSTEM LOG

Use the QLA Control Panel to specify how the server regulates license usage among the client computers. As a super administrator, you can view information about license usage among the Quark applications that are using QLA. You can view the logs and set levels of error and event logging. From the available five levels, you can select different levels for different errors and events based on their significance in your workflow. Level 1 contains the highest-priority events; Level 5 contains all events. You can set the user information in the system log for troubleshooting issues you might experience with QLA. However, these privileges are only available for super administrators. For more information about troubleshooting QLA, see “Appendix A”.

MONITORING QUARK LICENSE ADMINISTRATOR ACTIVITY

The system log stores information about license usage activity among the client computers. It records information about events that have occurred, alerts the system has issued, and errors the system has generated. You can access log information using the Log Viewer in QLA, or you can open a system log text file stored on the server.

Using the Log Options dialog box, you can choose the activities to monitor through QLA, specify how long QLA will retain a record of the activities, and set priority levels for the usage activity.

Log Options dialog box
To specify the parameters of the system log:

1 In the QLA Control Panel dialog box, choose View → Log Options (Control+O on Mac OS, Ctrl+O on Windows). The Log Options dialog box displays.

2 In the Viewing Options area, select the types of information for the system to include in the system log screen. You can record Events, Warnings, and Errors in any combination.

   • Check Events to display events stored in the system log. An event is an action on the network that affects QLA; when an event occurs, QLA logs an entry. The events list can help you monitor activity or diagnose problems within the licensing network.
   
   • Check Warnings to display alerts that have been recorded in the system log.
   
   • Check Errors to display errors in the system log.

3 In the Logging Options area, select which types of information to store in the system log, which is stored in the “QLA.log” file on the server. You can record Events, Warnings, and Errors in any combination.

4 Make the appropriate modifications in the Purging Options area:

   • Enter the number of days to store an event, alert, or error in the logs before it is deleted in the Log purged after (days) field.
   
   • Enter the largest allowable size of the log file in the Maximum log size in Kb (64K increments) field. Enter this size in 64K increments. When the log file exceeds this size, the system renames it “QLAOld.log”, stores it on the server, and creates another log file.
   
   • Enter a logging level in the Logging Level field. Based on this level, the errors will be stored in the log file.

5 Click OK.

For detailed information about events, alerts, and errors, see “Appendix A”.

ACCESSING THE SYSTEM LOG
You can access the system log one of two ways: open a text file named “QLA.log” in the “Server” folder or display log information using the Log Viewer dialog box.

OPENING THE SYSTEM LOG FILE
To open the system log file, double-click the “QLA.log” text file on the QLA server. The file displays in a tab-delimited format.
DISPLAYING THE SYSTEM LOG THROUGH THE LOG VIEWER DIALOG BOX

Use the Log Viewer dialog box to display the log in a more orderly layout than that of the “QLA.log” file. To display the system log in the Log Viewer dialog box:

1. Choose View → System Log (Control+L on Mac OS, Ctrl+L on Windows) in the QLA Control Panel dialog box. The Log Viewer dialog box displays.

Log Viewer dialog box

The Log Entries area displays log information according to the settings you made in the Log Options dialog box (View → Log Options).

- **Severity**: Displays the type of activity for each log entry (an event, alert, or error).
- **Date Time**: Displays the date and time that the activity was recorded.
- **Source**: Displays the application in which the activity occurred.
- **Log Message**: Displays the event, alert, or error.
2 Choose an option from the **Select Source** drop-down menu to indicate the scope of the log:

- Choose **All Sources** to display messages from QLA and your licensed Quark product.
- Choose **QLA Primary Server** to display messages from only QLA Server.
- Choose **XPress** to display messages for only QuarkXPress.
- Choose **QuarkCopyDesk** to display messages for only QuarkCopyDesk.

3 Click **Refresh** to update the log entries.

4 Click **Options** to display the **Log Options** dialog box, where you can edit your log preferences.

5 Click **Close** to close the **Log Viewer** dialog box.

For detailed information about events, alerts, and errors, see “Appendix A”. 
Chapter 4: Notifications and Alerts

A notification or alert informs you of a potential issue so you can be prepared with a solution. QLA Server generates various notifications both to the QLA administrators and users so everyone can plan their license usage accordingly. This chapter describes these notifications and their purpose in detail.

**PRIMARY SERVER NOT AVAILABLE**

When the Primary QLA Server stops responding, this notification informs you that the primary server is not available and the backup server is active. You can immediately take measures to start the primary server again and ensure that the information that is now being stored on the backup server is protected. The system generates this notification only if both the primary and backup servers are set up at the site.

**PRIMARY SERVER AVAILABLE**

This notification informs you that the primary server is now available and active.

**BACKUP SERVER NOT AVAILABLE**

When the QLA backup server stops responding, this notification informs you that the backup server is not responding and only the primary server is running. You can immediately take measures to start the backup server again and ensure that your automatic fallback mechanism is always in place. This notification is generated only if both the primary and backup servers are set up at the site.

**BACKUP SERVER AVAILABLE**

This notification informs you that the backup server is now available.
LICENSE USAGE REACHING A PRE-DEFINED PERCENTAGE OF THE TOTAL RUNCOUNT

This notification informs you that the license usage for a particular serial number has reached a pre-defined percentage of the total runcount. This notification enables you to plan the usage of the remaining licenses to ensure that licenses are available to users when they need them. Configure this percentage in the QLA Control Panel. The default value is 80 percent of the total runcount.

REMOTE CHECK-OUT LICENSE REACHING PRE-DEFINED NUMBER OF DAYS OF ALLOCATED DURATION

This notification is sent to the application user (for example, a QuarkXPress user). This notification informs the application users that the duration allocated to their licenses has reached a pre-defined number of days and displays the time remaining before the license expires. To extend the duration of the license, users can request that you update the license. Using the QLA Control Panel, you can configure the percentage of license usage at which this notification is generated.

TIME-BOMBED LICENSE ABOUT TO EXPIRE

If some users have time-bombed licenses, you can set the number of days before the due date that a notification is sent to alert the user that the application is about to expire.

LICENSE FILE REACHING PRE-DEFINED NUMBER OF DAYS OF ALLOCATED DURATION

The system sends this notification to you to alert you that a license file is about to expire and displays the remaining time.
Appendix A: Troubleshooting

Even the most well-designed software is subject to failure. QLA ships with capabilities to help you recover quickly if a failure occurs. Following is a list of issues you might encounter while using QLA and suggestions for resolving each issue.

**ISSUES AND WORKAROUNDS**

SERVER HARD DRIVE FAILURE
If your hard drive fails, restore the server computer, reinstall the QLA Server software, then download new “QLALicense.dat” files from the Quark Web site.

A QUARK LICENSED PRODUCT HAS BEEN REINSTALLED
When you reinstall a Quark application that uses QLA (for example, QuarkXPress, QuarkDMS, or QuarkDDS), you will need the IP address and port number information for the QLA server. You can locate this information in the “QLAControlLog.properties” file in the “Client” folder that is inside the “Quark_License_Administrator” folder on your hard drive. QLA Server also displays this information when running as an application.

When you reinstall the QLA Server software on a new computer, you must also edit the “QLAControlLog.properties” file on all client computers to reflect the new IP address and port number. For information about editing the “QLAControlLog.properties” file, see “Appendix B” later in this user guide.

CHANGED PORT NUMBERS
If you change port numbers for the QLA server, visit the Quark Web site to download a new “QLALicense.dat” file and modify the port number information in the “QLAControlLog.properties” file (located in the QLA Control Panel folder) on each client computer. You also must change the port number in the “QLAClient.properties” file on each computer that is running Quark applications. For information about editing the “QLAControlLog.properties” file, see “Changing the Server Name or Port Number” in “Appendix B” later in this user guide.
**USING THE SYSTEM LOG FOR TROUBLESHOOTING**

You can use the system log as a resource for locating the source of trouble in the license administrator system. By displaying the system log (View → System Log), you can view information about events, alerts, and errors that have occurred. Following is a list of possible activities that can be recorded and information about how you can use them for troubleshooting. For information about configuring the system log, see “Monitoring License Activity Through the System Log” in Chapter 3, “Administering Licenses.”

In addition to the system log, QLA Server generates another log called “QLAException.log”, which keeps track of the various issues, events, alerts, and errors. This log resides in the “Server” folder of the “Quark_License_Administrator” folder on your hard drive.

**ERRORS**

Following is the list of errors that might display in the system log.

<table>
<thead>
<tr>
<th>DISPLAYED MESSAGE</th>
<th>MEANING OF MESSAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A communications error is preventing the client from connecting with the server</td>
<td>The client encountered an issue while attempting to communicate with the server.</td>
</tr>
<tr>
<td>A connection error occurred while trying to connect to the server.</td>
<td>The client could not connect to the server.</td>
</tr>
<tr>
<td>All licenses have expired for: {application} {version} {serial number} {port}</td>
<td>The licenses for the specified application have expired.</td>
</tr>
<tr>
<td>All licenses have been allocated for: {application} {version} {serial number} {port}</td>
<td>No licenses are available for the specified application.</td>
</tr>
<tr>
<td>An empty log was retrieved.</td>
<td>No entries exist in the log.</td>
</tr>
<tr>
<td>An error occurred while authenticating the Quark server.</td>
<td>The Quark server did not pass the communications and encryption tests required for authentication.</td>
</tr>
<tr>
<td>An error occurred while initializing the heartbeat timer.</td>
<td>The heartbeat runs at a regular interval as determined by a timer. An error occurred while initializing that timer.</td>
</tr>
<tr>
<td>An error occurred while retrieving the extended license list.</td>
<td>The server was unable to retrieve the extended license list.</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>An error occurred while saving the license file.</td>
<td>The server failed to save the license file. This issue could result in the following types of failures: Future check-out or remote check-out failure Other errors while attempting to use the server. An initialization exception on server shutdown or launch.</td>
</tr>
<tr>
<td>An error occurred while synchronizing auxiliary license data.</td>
<td>The auxiliary license usage information was not successfully transmitted to Quark.</td>
</tr>
<tr>
<td>An exception occurred while connecting to the server.</td>
<td>An error occurred while connecting to the server.</td>
</tr>
<tr>
<td>An exception occurred while refreshing pools in server.</td>
<td>The pools could not be refreshed from the QLA Control Panel software because discrepancies existed between information that the server had and information that the client submitted.</td>
</tr>
<tr>
<td>An exception occurred while retrieving the check-out list.</td>
<td>The system was unable to retrieve the check-out list from the server (either because QLA Server was not running or because another failure occurred).</td>
</tr>
<tr>
<td>An exception occurred while retrieving the extended check-out list.</td>
<td>The system was unable to retrieve the extended check-out list from the server (either because QLA Server was not running or because another exception occurred).</td>
</tr>
<tr>
<td>An exception occurred while trying to connect to QLA Server.</td>
<td>The client could not connect to the server.</td>
</tr>
<tr>
<td>An exception occurred while trying to get number of runcount licenses available.</td>
<td>The server could not retrieve the runcount license list.</td>
</tr>
<tr>
<td>An exception occurred while trying to save data to the license file.</td>
<td>The system could not write to the license file. Changes that would have been written will be lost.</td>
</tr>
<tr>
<td>An exception occurred while validating deletion from node-lock pool.</td>
<td>A name could not be deleted from the pool because some licenses from the pool were checked out.</td>
</tr>
<tr>
<td>An exception occurred while validating customer maximum information.</td>
<td>The system encountered an issue while validating the maximum number of licenses available for the user. (The user checked out more auxiliary licenses than intended.)</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>An exception occurred while validating deleted users</td>
<td>The users or computers that you attempted to delete either have checked-out licenses or do not exist.</td>
</tr>
<tr>
<td>or computers.</td>
<td></td>
</tr>
<tr>
<td>An internal error occurred; extended license could not</td>
<td>QLA failed to add a license to the extended pool, remove a license from the extended pool, or save the extended license pool. The license is still valid, but no extended license is available as a result of this error.</td>
</tr>
<tr>
<td>be transferred.</td>
<td></td>
</tr>
<tr>
<td>An IO Exception occurred while reading the user name</td>
<td>The system could not read from the user name file.</td>
</tr>
<tr>
<td>file.</td>
<td></td>
</tr>
<tr>
<td>An IO Exception occurred while sending license usage</td>
<td>The system could not write to the license file. Changes that would have been written will be lost.</td>
</tr>
<tr>
<td>data.</td>
<td></td>
</tr>
<tr>
<td>Authentication failure with QLA Server or QLA Server</td>
<td>Either the server was already running and an attempt was made to launch it or the server could not communicate as a result of authentication failure.</td>
</tr>
<tr>
<td>was already running.</td>
<td></td>
</tr>
<tr>
<td>[check-in failure message]</td>
<td>When a check-in failure occurs, a message displays reasons the check-in failed.</td>
</tr>
<tr>
<td>[check-out failure message]</td>
<td>When a check-out failure occurs, a message displays reasons the check-out failed.</td>
</tr>
<tr>
<td>Data could not be read from the license or properties</td>
<td>The system could not read from the license file or one of the properties files.</td>
</tr>
<tr>
<td>files.</td>
<td></td>
</tr>
<tr>
<td>Exception while trying to save data to the properties</td>
<td>The system could not write to the properties file. Changes that would have been written will be lost.</td>
</tr>
<tr>
<td>file.</td>
<td></td>
</tr>
<tr>
<td>File Not Found Exception — user name file was not</td>
<td>The system could not find the user name file.</td>
</tr>
<tr>
<td>found.</td>
<td></td>
</tr>
<tr>
<td>[heartbeat failure message]</td>
<td>When a heartbeat failure occurs, a message displays reasons the heartbeat failed.</td>
</tr>
<tr>
<td>Heartbeats to the server have failed.</td>
<td>The client is no longer sending heartbeats to the server.</td>
</tr>
<tr>
<td>Internal Error — application information was not found</td>
<td>No application information is associated with this license.</td>
</tr>
<tr>
<td>for given license ID.</td>
<td></td>
</tr>
<tr>
<td>Internal Error — invalid lock type in license element</td>
<td>An invalid type of lock is associated with this license.</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Internal Error — invalid pool type in license element.</td>
<td>An invalid type of pool is associated with this license.</td>
</tr>
<tr>
<td>Internal Error — node-lock information was not found for given license ID.</td>
<td>No node-lock information is associated with this license.</td>
</tr>
<tr>
<td>Internal Error — unable to increment count for the extended license element.</td>
<td>The system was unable to increase the number of extended licenses correctly.</td>
</tr>
<tr>
<td>Invalid application name and version.</td>
<td>The application name and version combination the user entered does not exist in the license file.</td>
</tr>
<tr>
<td>Invalid license file.</td>
<td>The license file has been tampered with or is damaged.</td>
</tr>
<tr>
<td>Invalid license file path was given to the server.</td>
<td>If no path to the license file is included during initialization, the server cannot launch.</td>
</tr>
<tr>
<td>Invalid node-lock information sent to the server.</td>
<td>The server did not receive correct node-lock information from the client.</td>
</tr>
<tr>
<td>Invalid serial number: {serial number} {port}</td>
<td>The serial number is not registered with this copy of QLA.</td>
</tr>
<tr>
<td>Invalid session key was passed to the server.</td>
<td>The client and server maintain a unique conversation as identified by a “session key.” The client attempted to send an invalid session key to the server.</td>
</tr>
<tr>
<td>IO Exception error</td>
<td>An input or output error occurred.</td>
</tr>
<tr>
<td>IO Exception — writing to the user name file.</td>
<td>The system could not write to the user name file. Changes that would have been written are lost.</td>
</tr>
<tr>
<td>License ID is invalid.</td>
<td>The license ID is not valid.</td>
</tr>
<tr>
<td>No license keys exist for serial number.</td>
<td>No license key for the serial number exists.</td>
</tr>
<tr>
<td>[reclaim license failure message]</td>
<td>When a reclaim license failure occurs, an alert displays reasons the server failed to reclaim a license that was not in use.</td>
</tr>
<tr>
<td>[remote check-out failure message]</td>
<td>When a remote check-out failure occurs, a message displays reasons the remote check-out failed.</td>
</tr>
<tr>
<td>[remote check-in failure reclaim message]</td>
<td>When a remote check-in failure occurs, a message displays reasons the remote check-in failed.</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Server initialization failed.</td>
<td>The QLA server did not initialize success fully.</td>
</tr>
<tr>
<td>The control panel client is not valid.</td>
<td>An internal error occurred within the QLA Control Panel software.</td>
</tr>
<tr>
<td>The extended license could not be checked in.</td>
<td>The client could not check in an extended license.</td>
</tr>
<tr>
<td>The server could not be authenticated.</td>
<td>The server failed the authentication process.</td>
</tr>
<tr>
<td>The server object has not been initialized.</td>
<td>The server could not be initialized.</td>
</tr>
<tr>
<td>The user name file was not found.</td>
<td>The system could not find the file that contains the user name.</td>
</tr>
<tr>
<td>This client could not check in the license.</td>
<td>The client could not check in a license.</td>
</tr>
<tr>
<td>Unable to connect to QLA Server.</td>
<td>The client could not connect to the server.</td>
</tr>
<tr>
<td>Unable to decrement count for application: {application} {version}</td>
<td>The number of licenses could not be decreased for the application.</td>
</tr>
<tr>
<td>Unable to get the license keys from the server for serial number.</td>
<td>An error occurred while retrieving the license keys for the serial number from the server.</td>
</tr>
<tr>
<td>Unable to initialize the ORB.</td>
<td>The QLA server is dependent on being able to use an Object Resource Broker (ORB) for communication. The ORB did not successfully initialize.</td>
</tr>
<tr>
<td>Unable to read from the license file.</td>
<td>The file containing the license data cannot be read.</td>
</tr>
<tr>
<td>Unable to set license keys for serial number.</td>
<td>An error occurred while setting the license keys for the serial number from the server.</td>
</tr>
<tr>
<td>All licenses for [Appl.Name] [Appl.Version][Serial Number] [clientIPPort] are reserved in a list.</td>
<td>All licenses for the application are reserved in a pool or a list.</td>
</tr>
<tr>
<td>Node Lock check-in failed.</td>
<td>Node Lock check-in was unsuccessful.</td>
</tr>
<tr>
<td>The Remote License File is corrupt.</td>
<td>The remote license file is damaged.</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Either your IP address or your host name is invalid for this license file.</td>
<td>The Host ID or the IP address is invalid in the license file.</td>
</tr>
<tr>
<td>Invalid IP address for this license file.</td>
<td>The IP address is invalid in the license file.</td>
</tr>
<tr>
<td>The IP address you entered does not exist.</td>
<td>The IP address in the license file does not exist in your network.</td>
</tr>
<tr>
<td>Invalid host name for this license file.</td>
<td>The Host ID is invalid in the license file.</td>
</tr>
<tr>
<td>The license file does not exist.</td>
<td>The license file could not be found.</td>
</tr>
<tr>
<td>The license file is corrupt.</td>
<td>The license file is damaged.</td>
</tr>
<tr>
<td>QLA User Manager initialization failed.</td>
<td>QLA User Manager was not initialized.</td>
</tr>
<tr>
<td>Unable to create local admin user.</td>
<td>An error occurred while creating a local administrative user.</td>
</tr>
<tr>
<td>An error occurred while modifying the password for the user.</td>
<td>An error occurred while changing the password for the user.</td>
</tr>
<tr>
<td>An error occurred while configuring the e-mail server.</td>
<td>The system was unable to configure the e-mail server.</td>
</tr>
<tr>
<td>An error occurred while sending the e-mail message.</td>
<td>An error occurred while the system was attempting to send an e-mail message.</td>
</tr>
<tr>
<td>Invalid host name in license file: The host name in your license file does not match the hostname on your machine.</td>
<td>The Host ID is invalid in the license file.</td>
</tr>
<tr>
<td>Computer is not part of the network or the IP address has changed.</td>
<td>Either your computer is not on a network or your IP address has changed.</td>
</tr>
</tbody>
</table>
Following is the list of events that might display in the system log:

<table>
<thead>
<tr>
<th>DISPLAYED MESSAGE</th>
<th>MEANING OF MESSAGE</th>
<th>LOGGING LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>A license was checked out: {application} {version} {serial number} {user name} {host id} {Source:source name}</td>
<td>The client successfully checked out a license for the application.</td>
<td>1</td>
</tr>
<tr>
<td>A license was checked in: {application} {version} {serial number} {user name} {port}</td>
<td>The system checked in a license for the specified application.</td>
<td>1</td>
</tr>
<tr>
<td>A license was checked out by: {user name}</td>
<td>The specified user checked out a license.</td>
<td>1</td>
</tr>
<tr>
<td>An auxiliary license was checked out: {application} {version} {serial number} {user name} {Host ID}</td>
<td>The client checked out an auxiliary license for the application.</td>
<td>1</td>
</tr>
<tr>
<td>An extended license was checked in: {application} {version} {serial number} {user name} {Host ID}</td>
<td>The system checked in an extended license for the specified application.</td>
<td>1</td>
</tr>
<tr>
<td>An extended license was checked out: {application} {version} {serial number} {user name} {Host ID}</td>
<td>An extended license was checked out for the specified application.</td>
<td>1</td>
</tr>
<tr>
<td>An extended license was granted.</td>
<td>The server assigned an extended license.</td>
<td>1</td>
</tr>
<tr>
<td>An extended license was not granted.</td>
<td>The server did not assign an extended license.</td>
<td>1</td>
</tr>
<tr>
<td>An invalid password was entered while logging on to the control panel client.</td>
<td>You entered an invalid password while logging on.</td>
<td>2</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
<td>LOGGING LEVEL</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Authentication with the QLA Client was successful.</td>
<td>The QLA server and client connected successfully.</td>
<td>5</td>
</tr>
<tr>
<td>End of recovery mode.</td>
<td>Recovery processing is now complete.</td>
<td>2</td>
</tr>
<tr>
<td>Extended license list was retrieved successfully.</td>
<td>The server retrieved the list of extended licenses.</td>
<td>4</td>
</tr>
<tr>
<td>Heartbeat options were retrieved successfully.</td>
<td>The server retrieved the heart beat options that were stored in a properties file.</td>
<td>4</td>
</tr>
<tr>
<td>Invalid application information or no runcount licenses available.</td>
<td>The application information from the client was incorrect or no runcount licenses are available for the submitted application information.</td>
<td>1</td>
</tr>
<tr>
<td>License transfer from recovery pool was successful.</td>
<td>The server successfully transferred a license from the recovery pool.</td>
<td>5</td>
</tr>
<tr>
<td>Reclaimed license.</td>
<td>The server is reclaiming the client’s license.</td>
<td></td>
</tr>
<tr>
<td>Retrieved the list of license keys</td>
<td>The system retrieved license keys from the application for the serial number.</td>
<td>1</td>
</tr>
<tr>
<td>Initializing HWMUsage.dat Initializing Remote CheckoutPool Initializing QLANotification properties file. Initializing QLA Server properties file. Primary server is starting up. Server IP address &lt;IP&gt; Server port &lt;Port&gt; Ethernet Address &lt;HostID&gt;</td>
<td>The server objects are all initialized and ready to accept incoming requests from the clients.</td>
<td></td>
</tr>
<tr>
<td>Set license keys for serial number.</td>
<td>The system set license keys for the serial number.</td>
<td>5</td>
</tr>
<tr>
<td>The extended license was checked in.</td>
<td>The user checked in an extended license.</td>
<td>1</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The license count was retrieved successfully.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The log component has been initialized successfully.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The Quark server has been authenticated.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The server check-in response was OK.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The server did not grant a license.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The server granted a license.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The server has been authenticated.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The server was shut down successfully.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future remote license file expired before license was obtained. License is being reclaimed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request for future license added to queue [ApplName][ApplVersion][SerialNumber][UserName][HostID].</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Future license is checked out.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initializing QLANotification properties file.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initializing HWMUsage.dat.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MEANING OF MESSAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>The server retrieved the correct use for a particular number of licenses for a serial number.</td>
</tr>
<tr>
<td>The system log was initialized.</td>
</tr>
<tr>
<td>The Quark server provided the correct encrypted information and was authenticated.</td>
</tr>
<tr>
<td>The user checked in a license.</td>
</tr>
<tr>
<td>The server did not assign a license.</td>
</tr>
<tr>
<td>The server assigned a license.</td>
</tr>
<tr>
<td>The Quark server provided the correct encrypted information and was authenticated.</td>
</tr>
<tr>
<td>The user shut down the server.</td>
</tr>
<tr>
<td>A remote license file that had been reserved for future use was unable to obtain a license. QLA is reclaiming the license.</td>
</tr>
<tr>
<td>The system has added the request for a license for future use to the queue. The license will be activated later.</td>
</tr>
<tr>
<td>The system has activated the request for a future license.</td>
</tr>
<tr>
<td>The “QLA Notification Properties” file was initialized.</td>
</tr>
<tr>
<td>The “Auxiliary License usage” file was initialized.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LOGGING LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>1</td>
</tr>
</tbody>
</table>

APPENDIX A: TROUBLESHOOTING | 65
<table>
<thead>
<tr>
<th>DISPLAYED MESSAGE</th>
<th>MEANING OF MESSAGE</th>
<th>LOGGING LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initializing RemoteCheckoutPool.</td>
<td>The Remote CheckOut Pool is being initialized.</td>
<td>1</td>
</tr>
<tr>
<td>Initializing QLA Server properties file.</td>
<td>The “QLA Server Properties” file was initialized</td>
<td>1</td>
</tr>
<tr>
<td>Request for future license updated &lt;applname&gt; &lt;applversion&gt; &lt;serialnum&gt; &lt;username&gt; &lt;hostid&gt;</td>
<td>Request for a future license updated.</td>
<td>2</td>
</tr>
<tr>
<td>Node Lock check-out successful. {application name} {host id} {serial no} {username}</td>
<td>Node Lock checkout was successful.</td>
<td>1</td>
</tr>
<tr>
<td>The Ethernet address &lt;hostID&gt; has been located on your machine.</td>
<td>The Ethernet address of the machine is [Host ID].</td>
<td>1</td>
</tr>
<tr>
<td>The system is using Emergency Key Launch.</td>
<td>The system is using the Emergency key launch function to launch.</td>
<td>1</td>
</tr>
<tr>
<td>Your backup server is running.</td>
<td>The backup server is running.</td>
<td>1</td>
</tr>
<tr>
<td>Your primary server is running.</td>
<td>The primary server is running.</td>
<td>1</td>
</tr>
<tr>
<td>The server is shutting down.</td>
<td>The server is shutting down.</td>
<td>1</td>
</tr>
<tr>
<td>Password for &lt;user&gt; has been modified.</td>
<td>The password has been changed.</td>
<td>2</td>
</tr>
<tr>
<td>Unable to reserve the license for these dates because the license will expire.</td>
<td>The system is unable to reserve a future license for the specified dates because the license will expire by that date.</td>
<td>2</td>
</tr>
<tr>
<td>License was not reserved.</td>
<td>The system did not reserve the future license.</td>
<td>2</td>
</tr>
<tr>
<td>QLA User Manager initialization successful.</td>
<td>QLA User Manager was initialized.</td>
<td>2</td>
</tr>
<tr>
<td>Client (&lt;Control Panel Client login name&gt;) is logged on.</td>
<td>The client was able to log on.</td>
<td>2</td>
</tr>
<tr>
<td>The pool for user has been added, edited, or deleted.</td>
<td>The system has added, updated, or deleted a pool for this user.</td>
<td>3</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
<td>LOGGING LEVEL</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Pool/list has been added.</td>
<td>The system has added a new pool or list for the user.</td>
<td>3</td>
</tr>
<tr>
<td>Pool/list has been deleted.</td>
<td>The system has deleted a pool or list.</td>
<td>3</td>
</tr>
<tr>
<td>Pool/list has been updated.</td>
<td>The system has updated a pool or list.</td>
<td>3</td>
</tr>
<tr>
<td>Local administrative user {username} created successfully.</td>
<td>The system has created the local administrative user.</td>
<td>3</td>
</tr>
<tr>
<td>Local administrative user &lt;Admin username&gt; has been deleted.</td>
<td>The system has deleted the local administrative user.</td>
<td>3</td>
</tr>
<tr>
<td>Local administrative user &lt;Admin username&gt; has been modified.</td>
<td>The system has edited the local administrative user.</td>
<td>3</td>
</tr>
<tr>
<td>Password for user &lt;Admin username&gt; has been modified.</td>
<td>The password has been changed.</td>
<td>2</td>
</tr>
<tr>
<td>Server&lt;IP&gt; is receiving all data from server running at &lt;IP&gt;.</td>
<td>A server is retrieving data from another server.</td>
<td>2</td>
</tr>
<tr>
<td>Your primary server is running. Your backup server is switching to passive mode.</td>
<td>The primary server is, running so the backup server will work in the passive mode.</td>
<td>2</td>
</tr>
<tr>
<td>Your primary server is down. Your backup server is now active and functioning.</td>
<td>The primary server has stopped responding, so the backup server is now active.</td>
<td>2</td>
</tr>
<tr>
<td>Your backup server is down. Your primary server is still active and functioning.</td>
<td>The backup server has stopped responding. The primary server is still running.</td>
<td>2</td>
</tr>
<tr>
<td>Heart Beat Interval &lt;value&gt;</td>
<td>Heartbeat interval is &lt;value&gt;.</td>
<td>4</td>
</tr>
<tr>
<td>Heart Beat Retries &lt;value&gt;</td>
<td>Heartbeat retries is &lt;value&gt;.</td>
<td>4</td>
</tr>
<tr>
<td>Remote Heart Beat Interval &lt;value&gt;</td>
<td>Remote Heartbeat Interval is &lt;value&gt;.</td>
<td>4</td>
</tr>
<tr>
<td>Maximum Number of Days &lt;value&gt;</td>
<td>The maximum number of days is &lt;value&gt;.</td>
<td>4</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
<td>LOGGING LEVEL</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>A license for the XTensions module was checked out [ApplName][ApplVersion][SerialNumber][UserName][HostID].</td>
<td>The license for the XTensions module associated with the application was checked out.</td>
<td>1</td>
</tr>
<tr>
<td>A license for the XTensions module was checked in [ApplName][ApplVersion][SerialNumber][UserName][HostID].</td>
<td>The license for the XTensions module associated with the application was checked in.</td>
<td>1</td>
</tr>
<tr>
<td>E-mail notification parameters set.</td>
<td>The system has accepted the parameters for e-mail notifications.</td>
<td>3</td>
</tr>
<tr>
<td>Backup server is starting up: Server IP address: &lt;IP&gt; &lt;Port&gt;: available at the specified IP address and port number.</td>
<td>The backup server is available at the specified IP address and port number.</td>
<td>1</td>
</tr>
<tr>
<td>Your license file will expire on &lt;date&gt;.</td>
<td>The license file will expire on the specified date.</td>
<td>3</td>
</tr>
<tr>
<td>totalLicenses:&lt;totallicenses&gt; remainingLicenses:&lt;remaininglicenses&gt; serialNum:&lt;serialnum&gt; percentage:&lt;percentage&gt;</td>
<td>This message displays information about various parameters.</td>
<td>5</td>
</tr>
<tr>
<td>Your application &lt;SerialNum&gt; will expire on &lt;date&gt;.</td>
<td>The application will expire on the specified date.</td>
<td>3</td>
</tr>
<tr>
<td>A license was checked out: &lt;appliance&gt; &lt;applianceversion&gt; &lt;SerialNumber&gt; &lt;username&gt;&lt;hostid&gt; from pool: &lt;pool&gt;Source:&lt;&gt;</td>
<td>The application was checked out from the specified pool.</td>
<td>1</td>
</tr>
<tr>
<td>The following extended license was checked out from pool &lt;pool name&gt;: &lt;appliance&gt;&lt;applianceversion&gt;&lt;SerialNumber&gt;&lt;username&gt;&lt;hostid&gt;</td>
<td>The following extended license was checked out from the specified pool for the specified application.</td>
<td>1</td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
<td>LOGGING LEVEL</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Remote license due to expire: SerialNumber&lt;serialNumber&gt; Days&lt;days&gt; Date&lt;date&gt;</td>
<td>The remote license will expire on the specified date.</td>
<td>2</td>
</tr>
<tr>
<td>You have used some auxiliary licenses.</td>
<td>Some auxiliary licenses have been used.</td>
<td>1</td>
</tr>
<tr>
<td>Local administrative user &lt;user&gt; created successfully.</td>
<td>The system has created the local administrative user.</td>
<td>3</td>
</tr>
<tr>
<td>Backup server is starting up: Server IP address&lt;IP&gt; Server port&lt;port&gt;</td>
<td>The backup server is starting at the specified IP address and port number.</td>
<td>2</td>
</tr>
<tr>
<td>Primary server is starting up Server IP address&lt;IP&gt; Server port &lt;port&gt;</td>
<td>The primary server is starting at the specified IP address and port number.</td>
<td>1</td>
</tr>
<tr>
<td>An auxiliary license was checked in &lt;application&gt;&lt;version&gt; &lt;serial no&gt;&lt;username&gt;&lt;hostid&gt;.</td>
<td>A user checked in a license that was taken from the auxiliary pool.</td>
<td></td>
</tr>
<tr>
<td>The e-mail server was configured successfully.</td>
<td>The e-mail server is now set, and the server can send notifications.</td>
<td></td>
</tr>
<tr>
<td>A specified remote checkout licenses was successfully parsed &lt;application&gt;&lt;version&gt; &lt;username&gt;.</td>
<td>While updating a remote license file, QLA reads the selected remote license file and populates its data.</td>
<td></td>
</tr>
<tr>
<td>Future extended list is empty.</td>
<td>No future extended checked out licenses exist.</td>
<td></td>
</tr>
<tr>
<td>No licenses are checked out.</td>
<td>No users have checked out any licenses.</td>
<td></td>
</tr>
<tr>
<td>Extended checkout list is empty.</td>
<td>No users have checked out any extended licenses.</td>
<td></td>
</tr>
<tr>
<td>The pool user &lt;CPC admin username&gt; has been added, edited, or deleted.</td>
<td>The system has added, edited or deleted the specified user.</td>
<td></td>
</tr>
<tr>
<td>Your backup server has restarted. Your primary server is still active and functioning.</td>
<td>The backup server has restarted, but it is running in passive mode because the primary server is running.</td>
<td></td>
</tr>
</tbody>
</table>
REMOTE CHECK-OUT SUCCESSFUL. The remote check-out was successful.

FUTURE REQUEST UPDATED SUCCESSFULLY. The request for a future license was updated.

YOUR BACKUP SERVER IS RESTARTED AND YOUR PRIMARY SERVER IS STILL RUNNING. Both the primary server and backup server are running.

ALERTS

Following is the list of alerts that might display in the system log:

<table>
<thead>
<tr>
<th>DISPLAYED MESSAGE</th>
<th>MEANING OF MESSAGE</th>
<th>LOGGING LEVEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>A client aborted/crashed before checking in the license: {application} {version} {serial number} {port}.</td>
<td>Before the client had the opportunity to check in a license, it disconnected from QLA Server. The user might have initiated this disconnection, or the system might have quit unexpectedly.</td>
<td></td>
</tr>
<tr>
<td>Attempted to shut down the server while licenses were checked out.</td>
<td>This message simply alerts you that the server initiated shutdown while licenses are still checked out. You can shut down the server when licenses are checked out.</td>
<td></td>
</tr>
<tr>
<td>No licenses are available for: {application} {version} {serial number} {Host ID}.</td>
<td>No license is available for the requested serial number and application.</td>
<td></td>
</tr>
<tr>
<td>QLA Server is not running.</td>
<td>QLA Server is not running.</td>
<td></td>
</tr>
<tr>
<td>User attempted to do an invalid delete from the node-lock pool.</td>
<td>You attempted to delete a node-lock pool member from the pool while that user was running one or more checked-out licenses.</td>
<td></td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
<td>LOGGING LEVEL</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>No available licenses. Unable to reserve future license. <code>&lt;applname&gt;</code> <code>&lt;applversion&gt;</code> <code>&lt;serialnum&gt;</code> <code>&lt;username&gt;</code> <code>&lt;Host ID&gt;</code> .</td>
<td>The request for a future check-out has not been reserved in the queue because no licenses are available.</td>
<td>2</td>
</tr>
<tr>
<td>An invalid password was entered while logging on to the control panel client.</td>
<td>You entered an invalid password while logging on.</td>
<td>2</td>
</tr>
<tr>
<td>Unable to check out license for more than <code>&lt;&gt;</code> days.</td>
<td>The user cannot check out the license for more than the maximum number of days you specify.</td>
<td>2</td>
</tr>
<tr>
<td>The instance running at [IP] disabled the instance running at [IP].</td>
<td>An operation that was running on one computer disabled an operation that was running at another.</td>
<td>2</td>
</tr>
<tr>
<td>Unable to remotely check out the license because it has expired.</td>
<td>The license has already expired, and the user cannot check it out.</td>
<td>2</td>
</tr>
<tr>
<td>Unable to update the license file for past dates.</td>
<td>You cannot update a license file to be active on a date that has passed.</td>
<td>2</td>
</tr>
<tr>
<td>Unable to remotely check out licenses for past dates.</td>
<td>You cannot remotely check out a license for a date that has already passed.</td>
<td>2</td>
</tr>
<tr>
<td>Another user has already updated the pools/lists. The system automatically refreshed the latest data from the server.</td>
<td>Another user updated the pool or list you were trying to update. The data has been refreshed automatically.</td>
<td>2</td>
</tr>
<tr>
<td>The user you are attempting to delete is logged on.</td>
<td>The user you are trying to delete is logged on.</td>
<td></td>
</tr>
<tr>
<td>User <code>&lt;&gt;</code> entered an invalid user name or password while logging on to the control panel client.</td>
<td>The user entered an invalid user name or password while logging on to the control panel client.</td>
<td></td>
</tr>
<tr>
<td>DISPLAYED MESSAGE</td>
<td>MEANING OF MESSAGE</td>
<td>LOGGING LEVEL</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>The number of extended checkout days cannot be more than <code>&lt;days&gt;</code>.</td>
<td>Users cannot check out a remote license file for more than the duration allowed.</td>
<td></td>
</tr>
<tr>
<td>Unable to reserve request from auxiliary licenses.</td>
<td>You cannot generate a remote license file from the auxiliary pool.</td>
<td></td>
</tr>
<tr>
<td>The specified extended checkout licenses failed to parse.</td>
<td>While updating the remote license file, QLA is unable to read the selected remote license file.</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B: Post-installation Activities

After you successfully install the QLA Server and QLA Control Panel software, you might encounter situations in which you need to use the emergency license file, change contact information, or download the license file again. This appendix contains all of that information.

For information about installing QLA, see the “Installation Instructions.pdf” file on the QLA CD-ROM.

**USING EMERGENCY LICENSE FILES**

When you download the license file (“QLALicense.dat”), Quark sends a file named “QLALicenseBak.dat” to your e-mail address. This file is a temporary emergency license file that you can use if your server stops responding and you cannot immediately access the Internet to download a new license file.

To use the emergency license file if your server stops responding:

1. Install the QLA Server software on another server.

2. Assign the original server IP address to the new server. The emergency license file is locked to the IP address of the server, so the new server must use the same address as the old one.

3. Rename the emergency license file from “QLALicenseBak.dat” to “QLALicense.dat” and place it in the “Server” folder inside your QLA application folder.

4. If you are using a backup server, copy the renamed emergency license file to the “Server” folder inside the QLA application folder on the backup server.

5. Download a new license file from the Quark Web site. The emergency license file will work for up to five days after you begin using it.

6. After you download your new license file, replace the emergency license file on both the primary and backup server with the one you downloaded.

You can also use the emergency license file if your license file is damaged or the network card on your server stops working.
CHANGING CONTACT INFORMATION

Use the QLA License Registration page to change the contact information for your license files.

To change contact information:

1 Using the server computer, launch your Web browser and open the Quark QLA site at www.quark.com/products/qla or euro.quark.com/en/products/qla/. Click an option to specify the language for the Web pages. The Accessing Your Account page displays.

To ensure that client activity does not interfere with the license file download process, Quark staff recommends that you shut down the server each time you download a new license file.

2 Enter your registered license download name in the User Name field.

3 Enter your license download password in the Password field, then click Log On. The Account Information page displays.

4 Edit the necessary information.

5 Enter the path in the License File Location field or click Browse and locate the “QLALicense.dat” file on your server. This step is necessary because a new license file will download to your server when you update your user information. You can locate the “QLALicense.dat” file in the “Server” folder.

If you fail to locate the installed license file, you will lose the configuration data you entered in the QLA Control Panel dialog box.

6 Click Submit. The Download License File page displays.

7 On Mac OS, press Option while clicking Download. On Windows, click Download.

Mac OS only: If you do not press Option while clicking Download, your Web browser might attempt to display the contents of the license file.

Windows and Solaris only: If you are using Netscape as your browser application, right-click the Download link and choose Save Link As from the context menu. If you perform this step in another manner, your browser might attempt to display the contents of the license file.

The File Download dialog box displays.

8 Click Save this file to disk, then click OK. The Save As dialog box displays.
9 Use the **Save As** dialog box to open the “Server” folder inside your QLA application folder, then click **Save**.

Do not rename the file in the **Save As** dialog box. Renaming the license file causes it to malfunction.

After the license file has downloaded, the **Download License File** page once again displays.

10 Click **Log Out**.

11 If you are using a backup server, copy the “QLALicense.dat” file to the “Server” folder inside the QLA application folder on the backup server before you restart the primary server.

12 Start the QLA primary server, and then start the backup server.

If you need to update all of your contact information because your registered information is unknown or is no longer valid, contact Quark for assistance.

---

**RECOVERING FORGOTTEN PASSWORDS**

If you forget your user name or password, Quark can send this information to you in an e-mail message.

To recover a forgotten password:


2 Click **If you have forgotten your log-on information, click here**. The **Retrieving Log-on Information** page displays.

3 Enter the serial number for your Quark licensed product in the **Serial Number** field and click **Get Information**. A page displays to confirm that the requested information was sent to you.

Note the e-mail address Quark has on file to send your log-on information.

If Quark sent your log-on information to an invalid e-mail address, contact Quark to update your contact information.
DOWNLOADING NEW LICENSE FILES

You might occasionally need to download a new license file because of changes in your configuration or your hardware. For example, if the server host ID (Ethernet card address) or IP address changes for your primary or backup server, or if you want to change the port number, you need to download a new license file. Also, if you purchase auxiliary licenses, you will need a new license file.

You can download a new license file directly from the same Quark Web pages where you keep your contact information current.

To download a new license file:


   To ensure that client activity does not interfere with the license file download process, Quark staff recommends that you shut down the server component each time you download a new license file.

2. Enter your registered name in the User Name field.

3. Enter your password in the Password field, then click Log On. The Account Information page displays.

4. Enter the path in the License File Location field or click Browse and locate the “QLALicense.dat” file on your server. If you cannot locate this file on the server, or if your previous “QLALicense.dat” file is damaged, leave the field blank. You can locate the “QLALicense.dat” file in the “Server” folder.

   When you update QLA from a previous version, you must transfer the configuration information from the older version to the new license file to retain your license configuration. To transfer the information from the old license file to the new one, enter the path in the License File Location field or click Browse and the older version of the “QLALicense.dat” file that is saved on your server.

   If you fail to locate the installed license file, you will lose the configuration data you entered in the QLA Control Panel dialog box and all auxiliary license usage data.
5 Click **Submit**. The **Download License File** page displays.

6 On Mac OS, press Option while clicking **Download**. On Windows or Solaris, click **Download**.

**Mac OS only:** If you do not press Option while clicking **Download**, your Web browser might attempt to display the contents of the license file.

**Windows and Solaris only:** If you are using Netscape as your browser application, right-click the **Download** link and choose **Save Link As** from the context menu. If you perform this step in another manner, your browser might attempt to display the contents of the license file.

The **File Download** dialog box displays.

7 Click **Save this file to disk**, then click **OK**. The **Save As** dialog box displays.

8 Use the **Save As** dialog box to open the “Server” folder inside your QLA application folder, and then click **Save**.

**Do not rename the file in the **Save Current Document as** field (Mac OS) or **File name** field (Windows) in the **Save As** dialog box. Renaming the license file causes it to malfunction. Verify that the license file name is “QLALicense.dat.”**

After the license file has downloaded, the **Download License File** page displays.

9 Click **Log Out**.

10 If you are using a backup server, copy the “QLALicense.dat” file to the “Server” folder inside the QLA application folder on the backup server before you restart the primary server.

**If you need to download a new license file while the Quark Web site is unavailable, contact your Quark representative, who will send the appropriate files in an e-mail message.**

**If you need to update all of your contact information because your registered information is unknown or is no longer valid, contact Quark for assistance.**
CHANGING THE SERVER NAME OR PORT NUMBER

If you change the name of the computer — either the DNS name or the IP address you entered in the Server Name field — on which you have installed the QLA Server software, you must update it in your server information.

To change the server name or port number:


2. Change the necessary information, and download a new license file. For information about performing these tasks, see the “Changing contact information” and “Downloading new license files” sections earlier in this Appendix.

3. Open the “QLAControlLog.properties” file for the QLA Control Panel software.
   - If you are changing information for the primary server, update the “QLACONTROL_HOST=[server DNS name or IP address]” and “QLACONTROL_PORT=[server port number]” information to match the new server name or port number.
   - If you are changing information for the backup server, update the “QLACONTROL_BACKUPHOST=[server DNS name or IP address]” and “QLACONTROL_BACKUPPORT=[server port number]” information to match the new server name or port number.

4. Open the “QLAClient.properties” file on each client computer that is running the Quark application.
   - If you are changing information for the primary server, update the “QLASERVER_HOST=[server DNS name or IP address]” and “QLASERVER_PORT=[server port number]” information to match the new server name or port number.
   - If you are changing information for the backup server, update the “QLASERVER_BACKUPHOST=[server DNS name or IP address]” and “QLASERVER_BACKUPPORT=[server port number]” information to match the new server name or port number.

An efficient method of updating all the “QLAClient.properties” files is to create a master “QLAClient.properties” file with the new server information, then send the master file to all your users. Each user can drop the new file into his or her Quark application folder to replace the old one.
Glossary

**AUXILIARY POOL**
An auxiliary pool grants access to additional licenses, which you can purchase as you need them.

**BACKUP SERVER**
A backup server is a secondary server that automatically takes over license usage administration when the primary server is unavailable.

**EMERGENCY KEY LAUNCH (EKL)**
The Emergency Key Launch capability is a feature that enables you to launch QuarkXPress so you can temporarily run copies of the application on your client computers if the server is disabled.

**EXTENDED CHECK-OUT**
Extended check-out is the temporary removal of a license from the available pool of licenses so that it can be used without a connection to the QLA server. When a license is checked out, Quark License Administrator removes the license from its usual pool and adds it to the extended pool for the duration it is checked out.

**EXTENDED LICENSE**
An extended license is a license that can be checked out for a specified period without a connection to the QLA server.

**HEARTBEAT**
The heartbeat is the interval of communication between the QLA Control Panel Server software and your Quark applications to determine a valid connection exists between the two.

**LICENSE FILE**
A license file is a file, downloaded from Quark, that enables Quark License Administrator to regulate license usage on your network. The license file contains information about your server name and port number, which applications and serial numbers are managed by Quark License Administrator, the runcount that you have purchased for each application, and how many auxiliary licenses are available to you.

**LICENSE KEY**
A license key is a licensing parameter that is configured by a Quark application. QLA Server uses license keys to control a client application’s features appropriately when the server receives a new license request.

**LOCAL ADMINISTRATOR**
A local administrator is a type of administrator created by the super administrator to help with license administration for a specific department or other group. Local administrators can create and manage other users, and specify sub-administrators to help with administration tasks.

**LOG VIEWER**
A log viewer is a window that enables you to view errors, alerts, and events logged by the Quark License Administrator.

**NODE-LOCK LIST**
A node-lock list is a method of license allocation that assigns licenses to specific users or computers.

**NODE-LOCK POOL**
A node-lock pool is a group of users and computers that share a specified number of licenses.

**PORT**
A port is a channel through which any Quark application and QLA Control Panel client communicate with QLA Server.

**PRIMARY SERVER**
The primary server is the main server you use to monitor license usage with Quark License Administrator.

**QLA CONTROL PANEL**
The QLA Control Panel is the user interface for Quark License Administrator. Use the QLA Control Panel dialog box to allocate license pools, monitor remote (extended) licenses, synchronize usage data with Quark, configure system logs, and review logs.
**RUNCOUNT POOL**
By default, the runcount pool is the total number of licenses you purchased for each Quark application. As you assign licenses to other lists or pools, the system removes them from the runcount pool.

**SERVER NAME**
The server name is the DNS name or the IP address of the computer where the QLA Server software resides.

**SUPER ADMINISTRATOR**
A super administrator can create multiple local administrators in a hierarchy of administrators as necessary and grant them licenses. The super administrator is at the top of the administrator hierarchy.

**XTENSIONS MODULES**
XTensions modules are software that enhance the functionality of Quark applications.